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SECTION 1: Introduction

Welcome to the United States Geological Survey's Electron Microprobe user's manual. The 
following will give the first-time operator the basic knowledge and procedures needed to perform 
analyses on the microprobe and provide the already familiar user with a quick reference guide. This 
manual will not go into the techniques and theory behind microanalysis, but will instead concentrate 
on the physical and practical operation of the JEOL 8900 electron microprobe. Each chapter is a 
detailed explanation of one particular aspect of the probe, complete with figures and references. A 
quick reference guide or list of items and procedures for the more experienced user is included for 
each section (where applicable) in Appendix B.

This manual was written for all three US Geological Survey microprobe laboratories and is intended 
to be an overall user's guide to the operation of a JEOL 8900 series Superprobe. To accommodate 
the differences in the labs, there are three separate layout descriptions in Section 3. Some local 
discrepancies of procedure will exist, and where appropriate the following designations have been 
made:

(R) Applies to the Reston probe

(D) Applies to the Denver probe

(M) Applies to the Menlo Park probe

Check with the local lab personnel for site-specific procedures and consult the appropriate personnel 
if you have any questions regarding lab procedures not covered in this manual.

This manual does not attempt to include descriptions of every menu option found in the software and 
every button, knob, dial, or switch found on the hardware devices. Information about most of these 
items can be found in the JEOL reference manuals entitled JXA-8900 WDS/EDS BASIC 
SOFTWARE and JXA-8900S/M/L ELECTRON PROBE MICROANALYZERS and their 
supplements.



SECTION 2: Beginner's Guide to X-Windows

General introduction:

This section is mainly concerned with the operation of the computer software interface used to 
control the functions of the microprobe. Those who are familiar with UNIX's X-Windows or 
Microsoft's 'Windows' for DOS computers can skip this section as it deals with opening and 
closing windows and using the mouse. Apple/Macintosh computer users should note that there 
are differences between operating X-Windows and Macintosh windows systems, one major 
difference being that 'double-clicking' is usually not recommended, and is replaced with a more 
complex system of opening and placing windows. Other peculiarities in operation of the X- 
Windows environment are described below.

The operation of the microprobe is controlled by a Hewlett Packard Apollo workstation using an 
'X-Windows' environment. X-Windows is a system of 'windows', 'menus', and 'icons' which 
has been programmed to control almost all of the functions of the microprobe.

A 'window' is essentially an extra terminal screen through which a procedure can be controlled. 
The use of windows allows more than one procedure to be running at a time. Generally the 
controlling software will create appropriately designed windows.

A 'menu' is list of options to choose from. To select one of the options given in the menu, you 
must use the 'mouse' which is located on a pad to the right of the keyboard.

Throughout this manual, the hierarchy of menu choices is indicated by the symbol "->", as in 
Main Menu->Sub-Menu->Sub-Menu.

The basic mouse operations are 'clicking', 'draging' and 'double clicking'. A menu option may 
be selected by moving the mouse to point the cursor at the option, then 'clicking' the left 
button on the mouse once and releasing. Pressing the left button on the mouse and holding 
it down while moving the mouse is called 'dragging'. Pressing the left mouse button twice 
in rapid succession is called 'double-clicking' and is rarely used in the X-Windows 
environment.

An 'Icon' is a small picture that represents a menu item or window which is not open at the 
present time. Icons in the X-Windows environment are used to save space on the screen 
without closing windows completely. Further discussion of icons can be found below in 
the section describing windows.

Select menu options by moving the pointer over the box desired and clicking the left mouse 
button. A vertical list of options will be displayed. Move the pointer until the item you want is 
highlighted and click the left mouse button again. Once a menu option has been selected, an 
hourglass picture will be displayed indicating that the computer is busy loading software.

Important Note: Do not click the mouse buttons or type any characters while the 
software is loading, as this can lead to system lock-ups, loss of valuable 
operating time and damage to files.

After the software has loaded, a window outline will appear which can be moved about the 
screen by moving the mouse. Maneuver the outline to an appropriate position and click the left 
mouse button. A window will appear inside the outline. More than one window may be open at 
the same time, and they may overlap one another. In order to use a window when more than one 
is present on the screen, it must be 'active'. The active window is the window in which the



pointer is located. An active window usually has a green or blue border; an inactive window 
usually has a gray border. If the desired window is partially covered by another, it must be 
brought forward to the "top of the pile" by clicking on the window frame.

There are many control and display functions inside a window and along the border or frame 
around the window. Figure 2.1 is a basic window frame; the functions associated with it are 
described below:

1. Title bar. . .Displays the title of the window. Clicking on the tide bar will bring a window to 
the top of the pile. The window can be moved by placing the pointer in the tide bar, 
clicking and dragging to a new position.

2. Minimize button (iconize/iconify)...Placing the pointer over this button and clicking 
the left mouse button reduces the window to an icon and displays the icon at the right of 
the monitor screen. Iconizing a window does not halt any processes, but does unclutter 
the screen and speed up processing. To restore the window form, double-click on the 
icon.

Mnimize Maximize
Menu button Title bar
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Figure 2.1. Controls of a basic X-window frame.

3. Maximize button (full screen)...Placing the pointer over this button and clicking the left 
mouse button enlarges the window to fill the entire monitor screen. In some windows, 
the displayed contents may not be enlarged. To return the window to its original size, 
click on the maximize button a second time.

4. Resize border. . .Changes the size of the window as desired, and is located on all sides of the 
window, and at all four corners. The resize borders at the top and bottom adjust the 
window vertically, the left and right borders adjust horizontally. The borders at the corners 
will adjust the window both directions simultaneously. Clicking and holding the mouse 
button on a resize border will cause an outline representing the size of the changing 
window to appear. Drag the border to the desired size and release the mouse button.



5. Scroll bar...Controls the position of the cursor in the lines available for viewing in the 
window and allows one to scroll through more information than can fit on one screen. 
When a window is new, the scroll bar is a uniform gray. When the first text scrolls out of 
view, the gray section leaves a clear area at the top of the scroll bar. The more text has 
scrolled out of view, the smaller the gray area becomes, until the maximum number of 
saved lines (default=256) is reached. Scrolling is accomplished by clicking on the scroll 
bar:

Right mouse button 
Left mouse button 
Middle mouse button

scroll toward end 
scroll toward beginning 
jump to the location clicked

With the pointer at the bottom of the scroll bar, scrolling is done one screen at a time. With 
the pointer at the top of the scroll bar, scrolling is done one line at a time.

6. Window menu button...Brings up a separate menu which can be used to close, enlarge, 
shrink, or 'iconize' the window. For window menu operation, refer to the operation 
manual supplied with the workstation.

Inside the window frames are the windows themselves, which may contain numerous function 
controls. A typical window is displayed in Figure 2.2, and the basic window controls are 
described below:

2-D 
display

Arrowhead buttons

D'abg box

Buttons

Dabg boxes

Buttons

Scrol bar

Arrowhead buttons

Figure 2.2. Basic window controls.

1. Buttons. . .Execute commands when the user positions the pointer over the button and 
clicking.

2. Arrow head buttons. . .Allow devices such as the specimen stage and spectrometers to be 
driven in the specified direction by clicking on the appropriate button. Also used to move 
through choices in a list.



3. Scroll bar. . .Scrolls the item row displayed in a window or increases /decreases the numerical 
value in the key entry area. The scroll bar contains a position indicator and two arrow 
heads. To use the indicator, position the pointer over it and click and drag in the desired 
direction, releasing the mouse button when the desired position is reached.

4. Key entry area or dialog box...An area where numerical values or alphabetic characters 
are entered directly from the keyboard. Note: The pointer must be positioned 
inside the key entry area in order to type.

5. Two-dimensional display...Changes the position of specified items, such as the specimen 
stage. Position the pointer at the desired location and double-click the mouse button, or 
click and drag the box to the desired position.



SECTION 3: Layout

It is important to familiarize yourself with the physical layout of the controls for the microprobe 
in order to operate it efficiently. An extended description of each button, dial, switch, and 
knob is available in JEOL's JXA-8900S/M/L ELECTRON PROBE MICROANALYZERS 
manual and its supplements, so only a brief overview will be given here. Each microprobe 
laboratory of the US Geological Survey contains basically the same hardware devices, but due 
to the physical constraints of each laboratory and the particular tastes of the lab supervisors, 
their arrangements are slightly different

The rest of this section contains an illustration of the standard layout of the JEOL 8900, a 
description of hardware and controls, and brief descriptions of the variations in hardware of 
each USGS installation as of May 1994.
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The three JEOL 8900 Superprobes owned by the USGS have five wavelength spectrometers, 
four with two crystals each and one with four crystals. They are also equipped with an EDS 
system. For optical focusing, it has an optical microscope equipped with a TV camera, which 
transmits an image to the SONY color monitor using either reflected or transmitted light 
Almost all functions of the JEOL 8900 cari be accessed from the software; however, some 
functions also have hardware access from the console for convenience. More information on 
the instrument itself can be found in the JEOL manuals or in the Configuration window 
(choose Initialize -> Configuration from the main menu.)

Monitors:

The two lower screens are electron image (CRT) screens. The left screen displays a live 
time image. The right screen displays a digitized average of the image on the left 
screen and may be frozen with the FREZ button which toggles off and on. The 
scan speed for the screens can be set to FAST or SLOW buttons using buttons on 
the console control panel discussed below.

The VIEW button toggles the electron image screens through the possible image types: 
secondary electron (SEI), back-scattered electron topography (TOPO), back- 
scattered electron composition (atomic number contrast, COMP). The INST button 
will change the current image display conditions to SEI conditions; i.e., PCD out, 
probe diameter zero (minimum), PRBSCN (probe scan) on, scan mode PIC and 
speed SR.

The MODE button toggles through the display types: B_UP adds crosshairs to the 
display, LSP is a line scan profile, SPT is for spot positioning, and NOR is the 
normal display.

The SONY monitor displays an optical image of the sample stage, magnified to
approximately 600X. You can also see this image by looking through the eyepiece 
on the instrument and pulling out the back rod. With the rod in place, the image is 
displayed on the screen. The OMTV button on the console toggles the optical 
microscope light on and off. The SONY monitor is also used to display images of 
the right SEM screen, for subsequent printing on the SONY printer. See section 6 
for further information on the imaging and printing capabilities of the system.

SONY video monitor:

Magnification of the optical image on the video screen is about 600X.

The tick marks on the SONY screen are spaced approximately 10 microns apart.

The cross hairs on the SONY screen are not necessarily aligned with the beam position. 
Use a fluorescent sample to determine the position of the beam relative to the optical 
image. A small pen mark may be put on the screen for reference.

Cameras and printers:

The Polaroid camera is used to record images from the SEM screens. The photo LEFT 
and RIGHT buttons are used to choose which screen to photograph.

The SONY printer can print images displayed on the SONY monitor. Details for its 
operation are in section 7 of this manual.
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Summary files generated at the HP workstation and analytical data are printed on the dot 
matrix printer.

The Seiko color printer will print an image of the computer screen (sometimes referred to 
: as a screen dump) when either the remote green COPY button or the START- 

ENTER button on the printer is pressed.

Console/Control panel features:

The vacuum gauge displays the gun vacuum pressure. The display should typically read 
in the (2-6) x 10~6 torr range, although a rise into to the 10'5 torr range is normal 
during the sample exchange procedure. Ask your lab supervisor about acceptable 
and optimal vacuum readings.

The green high voltage (HV) indicator light below the right console screen will not light if 
the vacuum is not adequate. The high voltage will not go on if this indicator light is 
not lit.

The ACB button causes contrast and brightness for an SEI image to be adjusted 
automatically.

BRIGHTNESS and CONTRAST knobs on the console control panel are used to adjust 
the secondary electron image (SEI) display only. Back-scattered (COMP) and 
topographic (TOPO) image brightness and contrast knobs are located below the 
console screens.

The PCD (pneumatic cup device/probe current detector) button controls the insertion and 
removal of the Faraday cup a device which blocks the electron beam and measures 
the probe current When PCD button is lit, the cup is inserted into the line of the 
electron beam, blocking the beam from hitting the sample. With the PCD in, the 
beam current measured at the cup is displayed in the Present Values monitor 
window. With the cup removed from the beam path (button not lit), the beam hits 
the sample. The value of the sample current, that which is absorbed by the sample, 
is displayed.

The PRBSCN (probe scan) button toggles between scan mode and spot mode. When the 
button is lit, the beam rasters (moves very rapidly across an area) to provide 
scanned images. When PRBSCN is off (unfit), the beam is in spot mode.

The PROBE CURRENT knob adjusts the condenser lens current to increase or decrease 
probe current The FINE button toggles between coarse and fine adjustment mode; 
if the FINE button is lit, movement of the current knob will cause very small 
adjustments in the current

The MAGNIFICATION knob adjusts the electron image magnification between 40x and 
300,000x, though the quality of the image resolution degrades when the 
magnification is above lOOOx.

The FOCUS knob adjusts electron focus by changing the objective lens current In 
scanning mode, this knob adjusts the electron image focus. In spot mode, this 
knob adjusts the electron beam spot size (visible on a fluorescent sample such as 
MgO). When the probe diameter is set to a value other than zero in the Electron



Optical System (EOS) conditions in the EOS window, the FOCUS knob is 
disabled.

Joystick control panel:

The joystick controls the x-y movement of the stage. The READY light must be blinking 
for the joystick controls to work. Press the REQ button to activate the joystick 
controls if the READY light is not blinking or the stage will not respond to the 
controls.

The Z-buttons control the z-direction movements of the stage (i.e., optical focus).
Depressing the FAST button in conjunction with one of the Z-buttons will increase 
the speed of movement.

The TEST button jogs the stage to remove backlash and check x, y, z positioning.

The STORE button stores the stage position if the software is expecting a stage position 
to be input.

Optical microscope:

Images from the Optical (light) microscope are viewed primarily on the SONY monitor. 
These images may be transferred to the PC or recorded on the SONY video printer.

Workstation computers:

All USGS microprobe laboratories are controlled through a Hewlett-Packard 9000/7451 
computer. All laboratories also have Data General 300 series Aviion workstations which 
function as servers, and can be used to access the HP data processing software (see Data 
Management, Section 15).

Reston Laboratory Information:

The Eastern Region microprobe is located in room 3B-205a (phone: 703-648-6743) at the 
Reston National Center of the USGS. The laboratory in Reston can be contacted 
via electronic mail at the following address: jmcgee@lunatic.er.usgs.gov. Please 
address correspondence to James McGee.

Differences from the standard layout illustrated in Figure 3.1 for Reston include the
following: the SONY thermal printer and the Polaroid camera are located to the left 
of the console, as is the vacuum gauge. The Seiko color printer is to the right of the 
console behind the monitor, with a remote control button located near the monitor. 
The dot matrix printer is to the right of the monitor, and the magneto-optical disk 
drive is on top of the console. To the right of the HP monitor is a 386 PC for use 
in data transfer and image processing.

In addition to the obvious components, there is a Data General Aviion 310 workstation in 
the outer lab (room 3B-205) which is connected to the probe via the network and 
can be used for anlayzing data, image processing, etc. The Aviion has an 
associated HP LaserJet III printer as well as a 3 1/2" floppy drive and a cartridge 
tape drive.
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Denver Laboratory Information;:

The Central Region JEOL 8900 Superprobe is located in room G1601 in building 20 of 
the Denver Federal Center (phone: 303-236-3188). The laboratory can be contacted 
via electronic mail at the following address: gmeeker@usgsprobe.cr.usgs.gov. 
Correspondence should be addressed to Greg Meeker.

In Denver the only differences in the set up illustrated in Figure 3.1 are in the location of 
peripheral devices.

The Denver microprobe lab also has a 486 DOS system PC and a Data General
Workstation. The PC contains spreadsheet, image processing, and word processing 
software, with both 3 1/2" and 5 1/4" floppy drives.

The Data General 300 Workstation has a 3 1/2" floppy drive, a 32 track cartridge drive 
and a CD ROM drive. An HP LaserJet IV laser printer is connected to both the PC 
and the DG workstation via the USGS computer network.

Menlo Park Laboratory Information:

The Western Region microprobe is located in Building 11 on the Menlo Park campus 
(phone: 415-329-5089). The laboratory in Menlo Park can be reached via 
electronic mail at the following address: lcalk@condor.wr.usgs.gov. Please 
address correspondence to Lewis Calk.

There is a separate alarm system for building 11, and users must get instructions on 
arming and disarming the system before running the instrument alone or after 
hours.

The instrument, console and workstation are a standard JEOL layout (Figure 3.1).

The workstation and 386 PC, are hooked up to the HP printer between them. The 386 
has two floppy drives, one 3.5 inch and one large format (5.25 inch).

The Data General Aviion 300 Workstation has CD ROM and cartridge tape drives and is 
networked to the HP Worstation for use in data processing.

11



SECTION 4: Normal Start-up and Shutdown

The different centers have slightly different routines; steps below which do not apply to all 
centers are marked for the appropriate locations. (R=Reston, D=Denver, M=Menlo Park).

Start-Up: ,

1. Turn the HP and the SONY monitors on. If the previous user has shut down
normally, the workstation computer screen should have the JEOL EPMA menu at 
the top and the EPMA and CONSOL icons in the lower right portion of the 
screen. The EOS Monitor, (R, D) Filament and Present Values windows(R, M) 
should also be displayed. If the EPMA menu is not displayed, click the mouse 
anywhere on the background, choose EPMA Menu from the list, and wait for the 
system to load the software.

2. Check the vacuum on the vacuum gauge located on top of or adjacent to the main 
console (see Figure 3.1 or laboratory description). Except during or immediately 
after a sample change, or while the vacuum is recovering for some other reason, 
the vacuum should remain stable in the 10~6 torr range. Consult your lab 
supervisor for the optimal and acceptable vacuum reading at each location.

3. Turn on any peripheral systems which may have been shut down (i.e., printers, the 
PC, the magneto-optical drive), and turn up the brightness and contrast controls 
using the knobs located underneath the two CRT screens.

4. Bring up the EOS Monitor window if it is not already open (Monitor -> EOS
Monitor). This will display all the imaging control settings at a glance, and allow 
you to enter the commands using the software. (For most of these operations 
there are both hardware and software controls).

5. If the high voltage has been turned off, turn it on by pressing the ACCEL
VOLTAGE button on the main control panel; a representation of the beam will 
appear in the EOS Monitor diagram. (The accelerating voltage cannot be 
controlled from the EOS Monitor window unless it has already been turned on 
using the button on the main control panel.) In the EOS Monitor window, click 
on Ace. V. and in the resulting window incrementally adjust the accelerating 
voltage to the desired setting (normally 15 kV).

6. (R only) If the Filament window is open, indicating that the filament was left under- 
saturated, the previous saturation level can be reached automatically by clicking 
on Reset. (This does not work if the Filament window has been closed since 
desaturating the filament.). If the filament needs to be resaturated, see the 
instructions at the end of this section (Section 4, Filament Saturation).

7. Start the beam rastering by pressing the PRBSCN button on the main control panel 
(lit = ON) or by clicking Scan in the EOS Monitor

8. Set the view to secondary electron image (SEI) using the VIEW button on the 
console control panel or the button in the Image signal section of the Scan 
Control window. Choosing B_UP mode will cause cross-hairs to be 
superimposed on the image. The CRT screens will display the VIEW and the 
magnification.
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9. To scan at TV speed, click on the FAST button on the main control panel or choose 
Scan speed SR in the Scan Control window of the EOS Monitor. Set the EOS 
scan mode to normal either by toggling through the options with the MODE 
button on the control panel or by choosing PIC in the Scan Control window.

10. Adjust the magnification to 40x using the Magnification knob on the main control 
panel or using the button in the EOS Monitor. This button is only functional if the 
beam is rastering (the PRBSCN button is lit).

11. Unblock the beam by toggling the PCD button (lit = beam blocked) or by clicking 
on the picture of the cup on the EOS Monitor. Pressing the INST button on the 
main control panel will set the instrument to the basic secondary electron image 
(SET) configurations described above.

12. Adjust the brightness and contrast using the control knobs located on the lower right 
side of the main control panel until a satisfactory image is displayed.

13. Press the OMTV button to illuminate the sample and get a light optical image on the 
SONY monitor. Also make sure that the SONY monitor, the optical power 
supply and the SONY color monitor are turned on. If the SONY monitor is dark 
or blank and all the above settings are correct, the focus is probably out of 
adjustment Adjust the focus with the joystick controller, using the FAST button 
in conjunction with one of the arrow buttons until the cross hairs appear on the 
SONY screen. If you still cannot get an optical image, the beam may not be on 
the top surface of a sample or holder and you should move the stage using the 
Stage Monitor window from the Monitor menu and/or the joystick.

14. (R always; D, M as necessary) Check the Electron beam focus and location in 
relation to the crosshairs by moving to a fluorescent sample such as benitoite, 
wollastonite or MgO~see stage map or ask lab attendant to locate an appropriate 
sample. With PRBSCN off decrease the illumination (knob on spectrometer 
panel beneath the sample airlock lever) to make the spot clearly visible on the 
SONY monitor. With the probe diameter set to zero (EOS Monitor window), use 
the FOCUS knob on the main control panel to minimize the spot size. The SEI 
image is in sharpest focus when the spot size is at a minimum. If the fluorescent 
spot is not well centered, the gun shift needs to be adjusted by a lab attendant 
Also, if the fluorescent spot does not expand concentrically around the crosshairs 
as the focus know is adjusted, the objective lens aperture must be centered by a 
lab supervisor.

15. If everything looks normal, change to your personal directory space by choosing 
Initialize -> Change Directory. A window will open stating the current home 
directory. Type the path to your login directory in the bar provided, then click 
OK. If you do not have your own separate directory space, the appropriate path 
name here is /users/jxl. The current home directory is displayed in the tide bar 
of the EPM A menu.

16. At this point you can continue to the sample exchange procedure and begin your 
normal routine for an analysis session.
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Filament Saturation and Beam Alignment:

This procedure is not usually necessary in Denver and Menlo Park, though the beam 
alignment and position should be checked no more than once per session to insure excellent 
results.

1. Open the EOS Monitor window. (Monitor -> EOS Monitor) A schematic diagram 
of the column will appear. Changes made in this window are sent to the system.

2. The ACCEL VOLTAGE button on console must be lit and the high voltage (HV) 
on. In the EOS Monitor window, click on Ace V. and incrementally set the 
desired voltage (usually 15 kV).

3. Open Gun Bias in the EOS Monitor window and select the setting button marked in 
green. If only pink buttons are visible, the setting is already correct.

4. Position the beam on a smooth, non-vulnerable spot (like brass holder).

5. Turn the PRBSCN on and take the PCD out.

6. Choose SEI mode, FAST scan mode, magnification ~ lOOOx.

7. Click on Filament to open the Filament window. Click Signal to open the Scan 
Control window and set EOS mode to EMP (emission pattern) to display an 
image of the filament. The spot should be centered on the screen; if it is not, 
choose Gun Tilt and adjust until the spot is centered. The adjustment of Gun 
Tilt should not usually be necessary. (If starting from a very low filament value, 
use this EMP display for initial filament saturation.).

8. With EOS mode set to EMP in the Scan Control window, set Scan mode to LSP
(line scan profile). Adjust brightness and contrast knobs on console to obtain a 
Gaussian profile visible on left screen, then click arrows in the Filament window 
to lower values until peak begins to shrink.

9. Cycle between these two steps until increasing the filament current causes little 
change in the Gaussian profile:

  Increase current (click right arrow in Filament window)

  If the profile flattens on top, lower baseline with SEI brightness control on the 
main control panel until the profile is Gaussian again.

10. Back the filament down 2 clicks from the max, and record the filament setting on 
your log sheet. Saturation often occurs near 115-125 for 15 kV. It may be higher 
(~ 125-135) for a new filament, and it usually decreases slightly as the filament 
ages.

11. Set EOS mode back to NOR, make sure Scan mode is set to PIC, and close the 
windows.

12. Check the gun shift adjustment by moving to a fluorescent sample such as benitoite, 
wollastonite or MgO--see stage map or ask lab attendant to locate an appropriate 
sample. If the fluorescing spot is not visible with PRBSCN off, either turn off the 
OMTV light or decrease the illumination (knob on spectrometer panel beneath the
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sample airlock lever) to make the spot clearly visible on the SONY monitor. If 
the fluorescent spot is not well centered, the gun shift needs to be adjusted by a 
lab attendant.

13. After the filament is saturated and gun tilt and gun shift are properly aligned, adjust 
the beam current to the desired value (PCD in).

14. It is necessary to center the objective lens aperture so that the beam has the proper 
shape. Follow the instructions in step #12 above for checking the gun shift. Find 
a defect, pit, or any feature on the fluorescent mineral that you can center under 
the beam. With the beam diameter set at 0, turn the Focus knob on the control 
panel counter clockwise. Note if the beam "swings" off of the feature under the 
beam. If the objective lens aperture is properly centered, the fluorescent spot will 
simply expand concentrically around the point. If the point "swings" the aperture 
must be adjusted. Consult your lab supervisor for assistance if the aperture is out 
of adjustment.

Shut-Down :

Leaving the microprobe in the proper condition when you are through working is important 
for both the machine and the next user. In addition to following the shut-down procedure 
which follows, remember to take with you anything that you brought into the room, as items 
left behind may get misplaced by others. If you must have your samples immediately, 
remove them from the sample chamber before you start the shut-down procedure; otherwise 
the next user will remove them and you can retrieve your samples later. If you are shutting 
the instrument down for the day follow Procedure 1 below. If running the instrument 
overnight, use Procedure 2. If possible, standards, sample holders and samples should be 
stored in a dessicator.

Procedure 1: (normal shut-down)

1. Set the beam on brass or somewhere off of standards, samples or epoxy.

2. Retract the transmitted light lens if it was being used by pressing the LENS button 
located inside the sliding cover on the front of the main console, below the sample 
exchange lever. The LENS button is not illuminated when the transmitted light is 
in the retracted position.

3. Select the Secondary Electron Image (SEI) using the VIEW button on the main 
control panel or the Signal button in the EOS Monitor window. The image type 
being displayed is identified along the bottom of the left CRT screen.

4. Set the scan mode to the full picture setting either by pressing the PIC button on the 
main control panel, or by using the Mode button in the EOS Monitor window and 
choosing FULL under Reduce Mode.

5. Turn up the magnification to its highest level (300,000x) using the
MAGNIFICATION knob on the main control panel, or use the Mag button in the 
EOS Monitor window (only functional if the PRBSCN is ON at the console). The 
magnification setting is indicated at the bottom of the left CRT screen.

6. Select the slowest speed setting by pressing the SLOW button on the main control 
panel until the slowest scan speed is attained, or use the Speed button in the EOS
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Monitor window and choose Scan speed S3. Watch the left CRT screen to check 
the speed. You may have to turn up the brightness to see the scan line on the 
monitor.

7. Blank the beam by pressing the PCD button on the main control panel, or click on 
the picture of the cup in the EOS Monitor window.

8. Turn the optical system off by pressing the OMTV button on the main control panel 
so that it is no longer lit.

9. Turn the probe scan off by pressing the PRBSCN button so that it is no longer lit, or 
use the control button in the EOS Monitor window.

10. (D, M) Turn the acceleration voltage off by pressing the ACCEL VOLTAGE 
button on the main control panel so that it is no longer lit and no beam image 
appears in the EOS Monitor window.

11. Turn off the SONY color monitor (green button below screen).

12. Turn down the brightness and contrast of the left and right CRT monitors as far as 
they will go using the thumb knobs located immediately underneath the 
monitors.  

13. (R) Open the Filament window in the EOS Monitor. Decrease the filament
saturation by clicking 10 times on the left-arrow button in this window. Leave 
these windows displayed on the screen in addition to the items described in step 
14.

14. Close the open windows on the HP screen until only the main EPMA menu, the 
EPMA and CONSOL icons and the Present Values window remain.

15. (M) Turn the PC and its monitor off. (D) Turn off the DG Workstation.

16. (D, M) Turn off the SONY and Seiko color printers.

17. Turn off the HP color monitor. The power switch is located on the lower right front 
of the monitor.

18. MAKE SURE THE GREEN VACUUM CONTROL BUTTON IS LIT!
The green button is located on the right side of the vacuum chamber next to the 
specimen exchange chamber isolation valve lever (refer to Figure 3.1). The green 
button light indicates that the sample exchange airlock is at atmosphere. If this 
button is not lit, press the button to vent the airlock. In Reston this will happen 
automatically whenever the gate between the sample chamber and the airlock is 
closed.

19. Complete the log book entry for your session, noting problems and solutions and 
any other pertinent information. (R) Please tape a copy of your measurement 
conditions to the back of the page.

20. Remove your printed analyses and any floppy disks used for saving your data, turn 
out the lights in the room and lock the door behind you.

16



Procedure 2: (run overnight)

1. Retract the transmitted light lens if it was used and is still in the chamber. This is
done by pressing the LENS button located inside the sliding cover on the front of 
the main console, below the sample exchange lever. The LENS button is not 
illuminated when the lens is in the retracted position. FAILURE TO DO THIS 
CAN SEVERELY DAMAGE THE INSTRUMENT.

2. Turn the optical system off by pressing the OMTV button on the main control panel 
so that it is no longer lit.

3. Turn off the SONY color monitor.

4. Turn off the HP color monitor. The power switch is located on the lower right front 
of the monitor.

5. (D, M) Turn the PC and its monitor off as well as the DG workstation if in use.

6. (D, M) Turn off the SONY and Seiko color printers.

7. (D, M) Turn down the brightness and contrast of the left and right CRT monitors as 
far as they will go using the thumb knobs located immediately andemeath the 
monitors.

8. (D, M) Make sure the green vacuum control light is lit before leaving. It is
located on the right side of the vacuum chamber next to the specimen exchange 
chamber isolation valve lever. If this is not lit, press the green button once so that 
it lights up.

9. (R, M) Make an entry in the log book.

10. Clean the instrument area of any material that was not present at the beginning of 
your session. PLEASE KEEP THE LAB CLEAN. Turn out the lights, close the 
blinds (M) and close/lock the door behind you.

17



SECTION 5: Sample Changing

This procedure assumes that your samples are ready to load into the microprobe, i.e., that they 
are in an appropriate holder, are polished, have been appropriately mapped or diagrammed for 
locating positions of interest, and have been carbon-coated to prevent charging, etc. These 
preliminary steps should have been taken prior to the beginning of the probe session. When 
the probe start-up routine has been completed, or whenever you need to exchange samples, 
follow the procedure below.

1. Check to make sure the LENS button on the control panel below and to the right of 
the sample exchange chamber (Airlock, see Figure 3.1) is not illuminated. If 
illuminated, press the LENS button (which is protected by a flip-down window) to 
remove the transmitted light lens. This will take about 30 seconds, and the LENS 
button light will go out when removal is complete.

WARNING: If the transmitted light lens is left inserted, serious 
damage will occur when you attempt to remove the sample holder 
assembly from the analysis chamber!!!

2. Block the electron beam by either pressing the PCD button (lit = blocked beam) on the 
main control panel, or by clicking on the picture of the Faraday cup in the EOS 
Monitor.

3. Select Monitor -> Stage Monitor. Clicking on the Sample Change button opens a 
small confirmation window. Click on OK, and the stage will move to the proper 
position for the exchange procedure.

4. After ensuring that the sample exchange chamber lid is in firm contact with the rubber 
gasket on the inside of the sample exchange chamber, press the lighted green 
vacuum control button located on the right side of the airlock next to the gate valve 
handle (see Figure 3.1).

5. After approximately 2 minutes the light in the green button will go out, indicating that 
the sample exchange chamber (or airlock) has been evacuated. (D, M: Wait an 
additional 2 minutes after the light goes out to allow the vacuum to stabilize before 
opening the isolation gate valve.) Open the gate valve slowly by rotating the handle 
forward and up 90° to horizontal.

Watch the vacuum gauge as you slowly begin to pull the handle out (to the right if 
standing in front of the chamber), pausing to keep the vacuum in the 10'5 ton- 
range. Once the vacuum is stable in the proper range, pull the handle firmly all the 
way open, then turn the handle down 45° to lock it in position.

6. Retrieve the sample holder inside the analysis chamber by sliding the handle at the end 
of the sample exchange rod all the way to the base of the sample exchange chamber 
lid. With the handle as close to the lid as it goes, turn clockwise 90° to engage the 
sample holder, and gently pull outward to the end of the rod. You can monitor the 
retrieval of the samples from he analysis chamber by looking through the sample 
viewing window.

7. Once the sample holder is in the airlock, close the isolation valve by reversing step 5
above. Rotate the valve handle up 45° to a horizontal position, and push it in. When it
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is completely inserted, rotate it down 90° until it locks in place. When the handle is in 
the proper position, press the green vacuum control button (not necessary in Reston); 
you should hear valves activating and a light hiss as the sample exchange chamber is 
vented. The green vacuum control button will light.

8. When the exchange chamber is at atmosphere (venting takes about 10 seconds), pull the 
entire exchange chamber lid outwards by lifting it lightly from the bottom edge and 
pulling gently on the sample exchange handle, in order to open the airlock for the 
sample exchange.

9. ALWAYS WEAR GLOVES WHEN HANDLING THE SAMPLES AND 
SAMPLE HOLDERS.

10. Remove the sample holder assembly by lifting it straight up off the T-shaped inner 
rod. The holder itself slides off the adapter base along two brass dovetail grooves 
if you need to change holders. Exchange samples and replace sample holder onto 
the adapter base, making sure the sample holder is pushed all the way to the front. 
Then replace the sample holder assembly on the T-shaped rod on the sample 
exchange platform.

11. Make sure the O-ring gasket is seated properly in the groove on the airlock lid. Close 
the sample exchange chamber lid and see that it is tightly pressed against the gasket.

12. Press the green vacuum control button to evacuate the sample exchange chamber. After 
approximately 2 minutes, the light will go off, indicating evacuation is complete. (D, 
M): Wait an additional 2 minutes before opening the isolation gate valve.)

13. Open the gate valve between the analysis chamber and the airlock (see Figure 3.1) by 
rotating the gate valve handle forward and up 90°. Watch the vacuum gauge as you 
slowly begin to pull the handle out (to the right if standing in front of the chamber), 
pausing to keep the vacuum in the 10~5 torr range. Once the vacuum is stable in the 
proper range, pull the handle firmly all the way open, then turn the handle down 45° to 
lock it in position, (see step 5, above).

14. Insert the shuttle and attached sample holder into the analysis chamber very slowly 
(15mm per second or slower to preserve the actual positions of stored stage 
coordinates) by sliding the handle at the end of the sample exchange rod all the way in 
to the base of the sample exchange chamber lid. With the handle as close to the lid as it 
goes, turn it counterclockwise 90° to disengage the sample holder, and pull it out to the 
end of the rod. You can monitor the insertion of your samples by looking through the 
sample viewing window in the lid.

15. Once the sample holder has been replaced, close the isolation gate valve by rotating the 
handle up 45° to a horizontal position and pushing it in. When the handle is in the 
proper position, press the green vacuum control button (not necessary in 
Reston); you will hear valves activate and a low hiss will be heard as the sample 
exchange chamber vents. The green vacuum control button will be lit when the 
exchange chamber is again at atmosphere.

16. Click the OK button in the Sample Exchange confirmation window on the computer 
screen to complete the exchange procedure.
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To Initialize Stage Position after Sample Exchange:

Often, after changing samples, the stage coordinates of the standards do not match the 
stored positions. This usually is the case when the user has pushed the sample holder 
into the analysis chamber too quickly (see step #14 above). Individual positions can be 
stored or their positions changed by choosing Monitor->Stage, clicking on Memory, 
highlighting position number and storing a position.

To check the integrity of previously stored positions, se the positioning button in the 
Stage Monitor window to drive the stage to the stored position for the periclase crystal 
(MgO). The resulting position should be close to the previously stored position for this 
mineral. If the initialization point has drifted considerably, leave the stage in this position 
(i.e., don't move it manually from the position stored with the MgO button).

1. Choose Initialize -> Present Positions -> Stage. While this window is open,
reposition the stage, with the cross-hairs on top of a distinctive feature (this will be 
unique to each lab, so ask lab personnel where to position the window), and click 
on the Position button to store this initialization point. Close this window.

2. Now if you drive the stage away from the periclase crystal and click on the MgO
button in the Stage Monitor window, the stage should be driven to the feature. This 
procedure makes it possible to reposition the stage accurately even after a sample 
exchange has taken place.

This procedure will fail (i.e., the new initialization point will not be stored) if the adjustment of 
the initialization point exceeds 0.5 mm, but a message to that effect will appear on the screen. 
If that occurs, see a lab attendant for a more complete initialization of the stage positioning.

'£

The only consequence of the failure of this procedure (or of omitting it) is that driving the stage 
to positions stored prior to the most recent sample exchange will not position the beam 
precisely at the previous point on the sample. If the off-set from the initialization point 
becomes large enough, the markers indicating position which are displayed in the Stage 
Monitor may be noticeably offset relative to the proper position on the sample holder diagram 
in the Stage Monitor window..
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SECTION 6: Imaging

This section is designed to help the inexperienced user obtain the various types of images possible 
on the JEOL microprobe. It will not go into detail on high-resolution, high-magnification imaging 
as that subject is lengthy and beyond what the typical user requires. In addition to optical (light 
microscope) images using either reflected or transmitted light, there are three different types of 
electron images available to the user on the JEOL 8900: secondary electron images (SEI), 
composition back-scattered electron images (COMP), and topographical back-scattered electron 
images (TOPO). The default on system start-up and the easiest image to work with is the 
secondary electron image.

Optical Imaging

Reflected light imaging:

Reflected light is the usual method of viewing samples optically. The OMTV button on 
the console toggles the light source on and off. The illumination level can be adjusted 
using the OM/OMT ILLUMINATION knob on the control panel at the front of the 
column.

Focus the image by using the Z-arrows on the joystick console. If the image brightens, 
you are headed in the right direction. Holding down the FAST button in conjunction 
with the Z-arrows causes faster motion. The image is considered to be in focus when the 
crosshairs are in sharp focus. Poorly polished samples and samples which are not level 
will be difficult to focus properly.

Transmitted light imaging:

You **MUST** be using the transmitted light (thin section) stage 
(platform has rectangular openings with space beneath them) or the 
instrument will be damaged.

The light source must be inserted into the column. If the LENS button on the control 
panel below and to the right of the sample exchange chamber is not lit, the transmitted 
light source is out of the column; to insert it, press the LENS button. (Flip down the little 
door which protects the button from being pushed accidentally.) The light source (black 
tube on the right side of the column) takes about 30 seconds to move into place. 
Open the EOS Monitor (Monitor -> EOS Monitor).

Click on the button marked OMTV until it is pink and displays "Transmit ON". This 
button is a toggle which cycles among transmitted light, reflected light ("OMTV On") and 
light off ("OMTV off1 ).

The toggle for the polarizer is next to the LENS button on the control panel.

Always remove the transmitted light arm from the column before changing 
sample holders. To remove the transmitted light arm, simply press the 
LENS button on the control panel. If the transmitted light arm is not 
removed before samples are exchanged, serious damage will result to the 
microprobe.
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Electron Imaging:

Images are viewed on the two CRT monitors of the control unit. The left CRT displays a 
live image of the sample, while the right CRT is a continuous average of scans (up to 
64). Also displayed on the CRT monitors are the image type, accelerating voltage, 
magnification, and a micrometer bar showing the scale of the image. Directly underneath 
the CRT monitors are brightness and contrast dials for each screen; on the left screen, 
these should be turned to their maximum for imaging. Adjust brightness of the right 
screen to match the left screen.

Image preparation

In order to view an image, the instrument must be configured properly. Most of the basic 
settings are set as defaults upon start-up of the machine, so the user may only need to 
adjust a few settings.

First, the accelerating voltage and probe current must be set and the electron beam must 
be focused. For basic imaging the user should use the same settings he or she will be 
using during analysis, typically 15-20 kV and 2.0 x 10'^ amp beam current. With the 
probe diameter set to zero (EOS Monitor window), use the FOCUS knob on the main 
control panel to focus the electron image. (See Section 4, step 14 under Start-Up 
Procedure, for complete instructions if there is a problem achieving good focus.)

Make sure you have a sample under the beam. To do this, turn on the microscope light 
(OMTV button) and use the joystick controller to find and optically focus on a suitable 
position. Remember to optically focus with reflected, not transmitted light. Turn the 
probe scan on (PRBSCN button lit), set the magnification to 40x and unblock the beam 
(PCD button not lit). Select the image type to be displayed using the VIEW button on the 
main control panel; this button cycles through the imaging options. Begin by selecting 
the SEI setting.

SEI (secondary electron imaging)

Once the probe scan is on and the beam is unblocked, an image should be visible on the 
CRT screens. For a basic SEI image configure the instrument as described below. If the 
image is entirely bright or dark after the beam is unblocked and the probe scan is on, the 
contrast and brightness are probably far out of adjustment. You can manually set the 
contrast and brightness by adjusting the knobs in both directions and "feeling" your way 
to the proper setting until an image appears, or you can let the instrument guide you.

Setting the contrast and brightness: Press the WFM (wave-form mode) button on the 
main control panel. A series of six horizontal bright lines will appear on the left CRT 
screen. Adjust the brightness and contrast knobs until a separate video wave-form line 
appears on the screen, and continue adjusting the knobs until the line is contained 
between the six bright lines and produces an irregular wave-form. Press the WFM 
button again and an image should appear on the CRT screens.
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Refining the image:

1. Set the scan speed to super rapid (SR) by pressing the FAST button on the main 
control panel or clicking on the Speed button in the EOS Monitor window. A Scan 
Control sub-window will appear and the Scan speed can be set.

2. Set the Scan mode to Picture (PIC) and the Reduce mode to Full in the Scan 
Control sub-window as above, or press the PIC button on the main control panel.

3. The magnification should initially be set to 40x to view the image, but should be 
increased to sharply focus the beam.

4. Set the probe diameter to 0 in the EOS Monitor window. The beam cannot be manually 
focused without doing so.

5. Focus the electron image using the focus knob located on the main control panel; toggle 
between coarse and fine using the COARSE/FINE button. The AFD button, located 
above the focus knob, will automatically focus the image in about 15 seconds, but most 
users will want to adjust it manually. For best results, increase the magnification of the 
image and then re-focus. Repeat this at higher and higher magnification settings until 
turning the focus knob when it is on the fine setting no longer alters the focus.

6. Adjust the brightness and contrast of the SEI image using the control knobs on the main 
control panel until the quality of the image is satisfactory.

COMP (back-scattered electron imaging)

The compositional (COMP) or back-scattered electron image is used to show differences 
in mean atomic number. The image varies in brightness depending on the mean atomic 
number of the phases in the sample. The higher the average atomic number in the phase, 
the brighter it will appear in the image.

There are several differences between setting up a SEI image and setting up a COMP 
image. First and most important is that they have different contrast and brightness 
adjustment knobs. The COMP image knobs are located underneath the two CRT 
monitors on the control unit and consist of separate coarse and fine contrast and 
brightness knobs. A second difference is that the sample illumination (OMTV button) 
should be turned off while viewing a back-scattered electron image because the detector is 
light sensitive. If you are using the COMP image to locate your analysis points you can 
leave the OMTV on, but you will have to continuously adjust the brightness and contrast 
settings in response to the varying reflectivity across your sample.

Select the COMP image using the VIEW button on the main control panel. Once the beam 
is unblocked and the probe scan is on, an image should be visible. For a basic COMP 
image configure the instrument as described in steps 1-6 under SEI imaging above, but 
use the contrast and brightness knobs for COMP images located below the console 
screens. If the image is dark or bright, the contrast and brightness are probably far out of 
adjustment. See the section on adjusting contrast and brightness controls in the SEI 
instructions above.
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TOPO (topographic imaging)

Setting up a topographical image is almost identical to that of the COMP image, but the 
pseudo-topographic effect is used to distinguish fine differences in height of the sample 
surface. The steps and controls are exactly the same except the TOPO fine brightness 
knob is separate from the COMP fine brightness knob. Follow all the procedures listed 
under the COMP image above to obtain a TOPO image.

Single-element survey imaging

It is possible to map the distribution of single elements and display the result in real time 
on the console screens as a pattern of dots. The size of the image is limited to 
approximately 0.75 mm or less, depending on magnification. At magnifications below 
about 2000x, x-ray intensity will be diminished by at least 10% at the edges of the image. 
This effect becomes visibly noticeable between 100 and 500x. NOTE: This technique 
is a much faster way to see chemical variations over a small area than making a preset 
digital map. However, it is totally qualitative and generally less sensitive; you can only 
view one element at a time; and it can only be documented on the SONY printer or with a 
Polaroid image (see Section 7.1). In short, this is a survey technique intended for 
locating phases and for choosing elements for preset mapping or quantitative analysis.

1. First, position a spectrometer on a desired element peak:

Peak-search positioning method: Choose Monitor-> Peak Search. Make sure that the 
beam is on a material that contains a sufficiently high concentration (greater than 10 
wt %) of the element of interest for the peak search to succeed. Click on Element, 
and with the arrow in the appropriate box, type in the element abbreviation. The 
software will automatically choose a channel and crystal for that element, but you 
may change it by clicking on the appropriate buttons.

Manual positioning method: Choose Monitor -> Rate Meter. Click on the button for 
the channel you wish to use. In the window for the chosen spectrometer, click on 
Element to open a periodic table. Choose the element from those available to you 
on that spectrometer, then click on the Set button at the bottom of the window and 
close the window. The chosen spectrometer should move automatically to the 
proper position. This method should only be used if you are sure that the correct 
peak position is stored.

2. On the console control panel, press the XRAY button once for channel 1, twice for 
channel 2, etc., until you have the desired channel displayed on the console screen. 
One can tune multiple spectrometers and toggle among five different elements (one for 
each spectrometer).

3. Set the scan speed to the slow so that white dots (not lines) are displayed on the console 
screens. Each dot represents an x-ray pulse counted by the detector from the tuned 
spectrometer. By zooming in and out one can see chemical zoning of single elements 
within a crystal or material.

4. To compare the single element image to the back-scattered (COMP) or SEI images, 
simply click on VIEW. When XRAY is chosen again, the console screen will show 
the last element viewed.
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SECTION 7: Photography and Printing 

Using the Polaroid Camera:

The Polaroid camera can capture images from either the right or the left console screen. 
In general, if the image is acceptable on the screen, the picture will turn out. If the 
picture is too dark, increase the contrast and brightness and try again, or use the 
waveform monitor as described in Section 6 under "Setting the contrast and brightness".

1. To adjust the image, the brightness knobs under the CRT screens should be set to 
their maximum. Follow the instructions under SEI imaging in Section 6 to get a 
suitable image on the screen. Although most users will want to set the contrast 
and brightness themselves, an automatic contrast and brightness adjustment can 
be performed by choosing the ACS button on the main control panel. For 
optimum results, set the monitor to the slowest scan speed before using this 
feature.

2. To load the camera, insert the film with the lever on the camera turned to L. With 
the proper side down (see film sheet), push the film in until it stops against the 
back and makes a clicking sound. Pull the film sleeve out gently until it catches.

3. To make a photograph choose the photo button located at the right side of the main 
control panel: LEFT to print an image of left screen, RIGHT for the right screen 
image. A slow scan will occur. When the scan is complete, the photo is finished 
and ready for developing.

4. To develop the photograph push the film sleeve back in until it stops. Turn the lever 
on the camera to P and pull the film firmly and evenly out of the camera. Follow 
the developing instructions on the film package. Then return the lever to L.

Using the SONY Video Printer:

The SONY video printer is used to capture images from the SONY monitor. The same 
functions are available on both the remote controller and the front panel of the printer.

Pictures to be printed must first be stored in the memory of the printer. Under some 
conditions, two full-screen pictures may be stored. A letter M in the lower right of the 
SONY screen indicates that you are seeing the image stored in memory, a letter S 
indicates that the picture is from the source.

To produce a basic picture:

1. (D, M) Select the image type to be photographed using the A and B source 
buttons on the front panel of the SONY monitor. These buttons toggle 
between the optical (normal operation) image and the image displayed on the 
right CRT screen (the "averaged" image). (R) The image must be selected 
using the printer's MENU functions: S-Video selects the optical image, Video 
selects the SEM image. Current selections are shown in green. Arrow buttons 
allow you to move around the menu. Choose MENU again to exit

2. Set the scan speed to SLOW (or S3 in the EOS Monitor window). OMTV 
should be ON for optical microscope images and OFF for SEM images, 
though this will only affect the contrast settings. Set brightness and contrast 
either manually or by pushing the ACB button.
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3. To store this image for printing, choose MEMORY-IN on the remote control 
or on the front panel of the SONY printer. If you are satisfied with the 
picture, choose PRINT and the image will be printed. If you want to make 
further adjustments, select the MEMORY/SOURCE button to toggle back to 
the source image and make the adjustments, then press MEMORY-IN again 
and press PRINT. If you try to print from the source image, the image in 
memory will be displayed, and printing will not occur until PRINT is chosen 
again.

To customize a picture:

1. Choose MENU on the printer or remote control to display an image of the 
menu choices on the SONY monitor. Current selections are highlighted in 
green, and the arrows are used to move around the screen.

2. (M, D)Select the image type to be photographed by using the A and B source 
buttons on the front panel of the SONY monitor as described above . Scan 
speed must be set to slow, and the OMTV should be OFF for SEM images, 
ON for optical images, although this affects only the contrast settings. 
Alternatively, (R) the image type can be chosen from the menu on the screen 
(the on-screen menu is displayed by pushing the MENU button on the remote 
control or on the front of the printer). Choose VIDEO from the on-screen 
menu for SEM images, i.e. whatever image is being viewed on the right CRT 
screen. Choose S (S-Video) for optical images.

3. Continue to Menu-2 if you wish to add a caption to appear outside the picture 
area in the lower left corner. To produce a caption, use the arrow to highlight 
the letter or symbol desired, then press EXEC to add that letter to the caption. 
If the caption screen displays OFF in the upper right corner, highlight the ON 
button and press EXEC to activate captions. After exiting the menu, a C will 
be displayed in the upper left of the screen if captions have been activated. 
This caption appears only on the SONY print.

4. If you wish to annotate your image (put words or symbols on the image), open 
the Monitor menu and choose EOS Keyboard (Monitor-> EOS keyboard). 
When the window opens, put the cursor arrow on the keyboard. Pressing the 
middle mouse button locks the arrows/cursor onto the EOS keyboard so that 
you do not lose control of this function by moving the mouse. Push "insert 
character" on the HP workstation keyboard and begin typing your comments 
or symbols. This will temporarily remove the information at the bottom of the 
screen, but this information can be re-displayed by pressing "insert character" 
again. Arrow symbols (<, >) will put arrows on the screen. You can move the 
cursor with the space bar or the directional keys to the right of the 
alphanumeric key pad on the key board. Annotated comments will stay on the 
screen for the next image unless they are removed using the "delete line" or 
"delete character" keys. Press the middle mouse button to unlock the cursor 
and exit from the EOS Keyboard. The annotations appear directly on the right 
CRT screen and are captured along with the image when the print is made. 
These annotations will remain and will print on the next image if they are not 
removed.

5. Press MENU to exit from the menu display and the source image will be 
displayed on the screen. Choose MEMORY-IN to store the image for
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printing and PRINT to produce the picture. To adjust the picture further, 
select the MEMORY/SOURCE button to return to the source image, make 
the necessary adjustments, then choose MEMORY-IN and PRINT.

To produce multiple small pictures on one page:

1. Choose MENU on the printer or remote control to display an image of the 
menu choices on the SONY monitor. Choose the number of pictures desired 
on the page (1, 4 or 9). Set the SEPARATOR option to ON if you want a 
border to separate the multiple pictures. If you are using separators, you 
cannot have a caption.

2. On exiting the menu, stars will appear on the SONY screen to indicate the 
positions of the pictures. The green star indicates the location of the next 
image to be stored, and can be changed using the arrow keys.

3. Proceed as with single pictures, toggling to source mode to set up a frame, then 
placing it in memory, and using the arrow keys to move, until all the frames 
are set as desired. Choose PRINT as before.

Using the Seiko Color Printer:

The Seiko color printer prints the screen of the HP workstation monitor. On the HP 
monitor, bring up the item you wish to print (most users take pictures of area analyses, 
or element condition windows). Press the START button on the top of the Seiko 
printer or the green button on the Seiko remote control. The printing process takes 
about a minute. Wait for printing to start before altering the monitor images.

When re-printing plots from a phase analysis it is best to reverse the image to get a 
white background rather than black. This can be done using the arrow keys next to the 
START button on the printer. First press ONLINE; the display on the Seiko will read 
"#1 PAPER NOR 1", with the final "1" blinking. Press the left arrow and NOR will 
blink. Press the down arrow to change NOR to REV, then press ONLINE and dump 
the image as above.
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SECTION 8: Standard Analysis

Standard analysis calibration data is shared among all users. Only the most recently acquired 
count data for a standard is stored on the disk.

Menu: Analysis -> Standard Analysis

After a few seconds the menu bar outline will appear and must be placed with a click of the 
left mouse button.

Sample Button:

This displays a menu of previously analyzed standards available, the last date they were 
measured, and whether data are available for WDS or EDS analysis or both. Be patient, 
as this window is somewhat slow to come up. Choose Name to sort the standards 
alphabetically or Date to sort them by most recent analysis date. Be aware that the 
element of interest may not have been standardized on the spectrometer and crystal you 
have selected on the date shown in this window... this is the last date the standard was 
used for any element Use the pointer to highlight the standard being selected.

Choose Search and enter the element of interest in the dialog box to examine all the 
previous standardizations for that element. A list of possible standards is displayed, 
and an appropriate one may be selected at this point.

If a previously unmeasured standard is needed, it is added by clicking the New button. 
This will prompt you only for the name of the new standard; enter the composition 
under Measurement -> Element Condition as described below.

Other options include renaming samples, deleting samples, and printing the standard 
data for the highlighted sample. PLEASE do not rename or delete standards 
without consulting a lab attendant.

Select OK when you have completed standard selection. 

Measurement Button: 

Condition Load:

If you previously created and saved analytical conditions for this standard in the 
Condition Store window, choosing Condition Load will allow you to recall them. 
Locate the stored conditions on the list presented, highlight it, and click the Load 
button. You still must update the beam current in the EOS Condition window, 
and check the stage positions in the Stage Condition window. It is wise to check 
other conditions to make sure that all is as you expect. NOTE: this Condition 
Load routine will only retrieve the conditions for one standard, not an entire suite 
of standards. See the discussion of default analysis conditions in Section 16.
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Standard Type:

You must decide whether you want to analyze your unknowns as metals or 
oxides. If you are analyzing silicates, generally, you, will want to analyze them as 
oxides. However, if you are analyzing for oxygen, op non-silicate materials, you 
must create new standardization files and standardize for all elements in your 
quantitative analysis setup as "metals". Mixing standards analyzed as oxides and 
metals in Quantitative Analysis routines leads to miscalculations by the 
workstation software. Previously created oxide and metal files should be 
distinguishable from among the standardization listings (metals may have the 
designation "m" or "metal" in the file name. Once a standardization is created as 
an oxide or a metal it should not be changed. Before closing this window, make 
sure Calibration Curve is turned OFF. (Its function is described in the Map 
Analysis section, p. 11-6).

Element Condition:

Standard Composition:
This item should not generally be needed by users. However, when a new 
standard is being entered, choosing this opens a window which allows you to 
enter the known composition of the standard in atomic, mole or weight 
percent. The element symbols, valences and percentages are typed in a 
column format For an existing standard, this window will display the 
composition data which has been entered for it If you need to copy a 
standard composition from an existing standard file to a new one (as you 
might if the same standard is on two different standard blocks) see the 
directions at the end of this section.

WDS Elements:
This window allows you to select the elements for measurement with WDS 
(wavelength dispersive spectrometry) on this standard by clicking on the 
desired elements in the periodic table. The available elements are those 
entered in the standard composition. You can choose to measure an element 
more than once, allowing the same element to be measured under different 
conditions (e.g., different spectrometers). Do not try to standardize on an 
element of low concentration; use major elements only.

WDS Condition:
Choosing this menu option will display the conditions that will be used for 
measuring the selected elements for this standard. Clicking on the element 
box at the top of any element condition description will open a screen which 
displays the master list of conditions for analyzing this element. (There 
should be a routine set for each possible crystal on the spectrometers on which 
this element can be measured).

You may choose to use or modify an existing set-up. To make a modification, 
click in the box of the item you wish to change and make your selection from 
the list presented or by typing in desired values. When you are finished, 
highlight the box above the set of conditions you wish to apply and exit the 
screen by clicking OK at the bottom.

Please do not change the PHA settings (Peak Height Analysis gain and 
window voltages) for any routine without consulting a lab attendant first
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EDS (Electron Dispersive Spectrometry) Elements:
Choose elements for EDS analysis in this window. This window functions 
in the same manner as the WDS Elements window (above). If the same 
element is specified twice for EDS analysis, you must specify two 
different x-ray lines.

EDS Condition:
Set the x-ray and ROI (Region of Interest) for analysis for EDS elements. 
If no data is set here, the most recently set conditions will be used, and by
default the ROI will be set to include both a and p lines. 

EOS Condition:

This window displays the Electron Optical System conditions to be used for 
analyzing this standard. Be aware that each standard has its own EOS 
condition file. On the console, turn the PRBSCN (probe scan) off to stop the 
beam from rastering. With the PCD in, set an appropriate beam current
(typically on the order of 2 x 10'8 amps = 20 nanoamps). Choose Read to 
enter the present instrument conditions into this window.

The EOS condition window should display the present probe current and 
accelerating voltage (usually 15 kV. This setting must be the same for both 
the standard and unknown when doing quantitative analysis). Do not alter the 
settings for the Condenser Lens or Objective Lens currents as these are set in 
conjunction with the probe current. Make sure the beam diameter is larger 
than 10 microns (adjustable in the EOS Monitor window).

A proper beam diameter should be set based on the types of phases you are 
analyzing. Some phases are less robust than others and can be damaged by a 
focused beam (especially at high beam currents), and damaged standards are 
often difficult to replace. Although a small beam diameter and higher probe 
current will give better counting statistics and more precise measurements, 
and the size of the samples may limit the beam size in some cases, for some 
phases the beam size will need to be expanded to protect against 
standard/sample damage and alkali loss (see Toubleshooting, section 16). It is 
advisable to keep the beam size used on the standard as close as possible to 
the beam size used on the unknown. Large differences in probe diameters can 
affect the measurement If the probe diameter needs to be reset in your
analysis file, click on the button labeled Probe Diameter (|im) and adjust the 
setting in the sub-window.

The settings for Magnification, Scan Mode and Scan Speed are unimportant 
since in normal standardization the beam will not be rastering during analysis. 
Click OK to save the conditions for automatic use during measurement. 
Choosing Set will set the instrument to the conditions currently displayed in 
this window.
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EDS Condition:

This window displays the operating conditions for EDS. The options in this 
window should read as follows for Standard Analysis and Quantitative 
Analysis;

i
Energy Full Scale: 10 
Spectrum Data Points: 1024 (default) 
Measurement Mode: LIVE 
Measurement Time: (has no effect) 
Aperture: 1

The aperture setting in the software bears no relation to the actual aperture 
setting of the detector. The aperture must be adjusted manually to a setting that 
will keep the dead time of the EDS detector between 20 and 40%. If the dead 
time is too low, not enough counts are reaching the detector, but if the dead time 
exceeds 40%, the detector is being swamped and missing too many counts. If 
both EDS and WDS analyses are being done, the beam current should be 
adjusted for WDS (e.g. 20 nA) and then the aperture should be adjusted to yield 
20-40% dead time. It is strongly advised that you discuss the EDS aperture 
setting with the laboratory supervisor before doing EDS quantitative analysis.

Stage Condition:

This window is used to set the stage positions for the points to be measured. 
Only the last position entered will be displayed. Click on Position Input, and a 
window with a diagram of the stage will appear.

To enter new positions:

1. To move the stage into position, click to indicate the approximate 
position on the stage with the pointer and select Move or use the 
joystick to move to the point of interest If this is a standard that has 
been analyzed recently, the coordinates which appear in the Position 
Input window should be fairly accurate. In this case, click the Move 
button and check to see that it has located the proper sample.

2. Focus the image optically using the Z-axis controls on the joystick 
control pad. Always focus the cross-hair by using the up arrow last 
so that the backlash is taken out of the gears and the computer will 
return to that position more precisely. Press the TEST button on the 
joystick control pad to check the location and focus of your position. 
If it is off, correct the position and repeat the test until it is satisfactory.

If for some reason, you wish to only use one standardization point (not 
recommended) proceed to steps 3 and 4. If you wish to accumulate and average 
multiple analysis points for your standardization, proceed to step 5.
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3. Click the Read button and then the Store button in the Position Input 
window, or press the STORE button on the joystick control pad to enter 
this as the stage position for measurement on this standard. If you use the 
STORE button on the joystick console, you will then have to press REQ to 
reactivate the joystick.

4. If necessary, edit the comment line by placing the cursor in the dialog box 
and typing. If no comment is typed in, the comment from the previous 
point will automatically be used.

5. Set the number of accumulations desired for the standard analysis by 
clicking on the Accumulations button. Typically you will want to 
accumulate and average at least three points per standardization. Type in 
the number of accumulation points desired, or slide the bar to the desired 
number, and then click OK.

To set coordinates for each of the accumulations click Confirm in the 
Position Input window. A tone will sound to alert you that the computer is 
ready to begin storing points, though no position data has yet been stored. 
A small window will open and remain open until positions are stored for 
each accumulation.

On the joystick control pad, choose a point to be analyzed, focus, press 
TEST to remove stage motor backlash, then re-focus if necessary. When 
satisfied with the focus and the position, press the STORE button on the 
joystick control pad to store that position as an accumulation point. A 
tone will sound, this time to alert you that the point has been stored, and 
you can move to the next position and repeat the procedure until all the 
accumulations are set, at which point the accumulations window will close 
automatically.

6. Click Apply to store the information in permanent memory, then click 
Close to close the stage window.

To modify existing positions:

1. Choose Input from the Stage Condition window. When the screen with 
the image of the stage appears, choose Move to drive the stage to the last 
previously set position for this standard.

2. Select Confirm. The stage will position itself at the point set for the first 
accumulation, and a tone will sound. You may move to a different 
position or adjust the focus of this position or make no change at all. Press 
STORE. Once the points have been set, they can be checked by clicking 
on Confirm. The stage will move to the next analysis point and beep 
when the STORE button is pressed. If you begin checking the analysis 
points using the Confirm function, you must go to all of the accumulation 
points you wish to analyze.

3. The sequence described in (2) will continue until all the stored positions 
have been checked. When you are satisfied with the positions chosen, 
click on Apply, then Close.
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After the Position Input window has been closed, you may choose One-by-One if 
you only want to analyze one standard at this time. Press Acquire in the window 
that appears and the analysis will be performed only for the standard listed in the 
Standard Analysis dialog box.

If you prefer to set up several standards to run consecutively, return to the Sample 
Button and select the next standard to be analyzed. Follow the steps above until 
you have set up all the standards you wish to measure, then proceed to the section 
entitled Preset Measurement below.

Condition Store:

If you are happy with the conditions as they are set up, and might want to use the 
same conditions again, save them here with a recognizable name. If this is done, 
you can retrieve them later using Condition Load.

Print-out Condition:

Use this to choose a full or brief output. Use full if you wish to have a hard copy 
of your count data. If you do not want a print out, turn off the printer or the print 
function. As stated below, only averaged counts are printed unless the X-Text 
window itself is printed by clicking on the Print button.

Measurement Mode:

If both EDS and WDS standard analyses are being executed, choose whether to 
do them at the same time (parallel) or separately (serial). If they are to be done 
separately choose the order in which they should be accomplished. If using 
parallel mode, be advised that EDS peaks may broaden due to noise from the 
WDS spectrometers.

Check Data:

If you need to eliminate a point from the calculation of the average for the 
standardization, or alter any other standard data after it has been collected, the 
data files can be altered via this window. There is a long delay in opening the 
Check Data window with no indication that anything is happening...be patient.

To examine an accumulation point, click the column heading designated Acm, 
and the number of accumulations for each standardization will become a new 
button. Click on the accumulations for the desired standardization, and a window 
will open showing the value for each accumulation in counts per second. Turn off 
the analyses you wish to omit by clicking on the buttons to the left of the 
numbers, and they will be left out of the standard calculation.

Choose Save to keep the adjusted values for use in calculations of unknowns. 
Even if Preset Measurement was used, only the standard named in the dialog 
box of the Standard Analysis window will be available to change. To examine 
to data from other standards you must select each standard, one at a time, using 
the Sample button on the left side of the Standard Analysis window as described 
in the beginning of this section.
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Survey Measurement:

Choose this process to take a quick measurement at the point currently under the 
beam to check the measurement conditions you have set up. These results are for 
checking conditions only, and cannot be used for quantitative or standard 
analyses.

Pre-set Measurement:

When all points on all standards have been chosen and entered as above, choose 
the standards to be measured by clicking on their buttons (ON=blue). Make sure 
the number of standards you expect to analyze matches the number at the bottom 
of the window. Click on Acquire and the chosen standards will be measured 
automatically.

While the analyses are occurring, a window will be open showing a moving pump 
and keeping you informed about how many accumulations have been completed, 
etc. This window will close when measurement is complete, but to stop the 
analyses at any time click the Accum Stop or the Stop button in this window and 
the measurement will end. Note that Accum Stop will not stop the analysis 
immediately. The microprobe will finish the analysis it is working on before 
quitting and then ask you if you wish to stop the analysis. Be patient.

Aborting the current analysis by pressing the Stop button is not recommended. 
Doing this often leads to software failures. If it is necessary and software 
problems do occur, follow the troubleshooting procedures (Chapter 16) to 
reestablish the software communications. Using the Utility -> Reset Analysis 
function immediately following use of the Stop button seems to prevent software 
failures.

Count data appears in a window labeled "X-Text" as the measurement is 
occurring. When the analysis is complete, a message to that effect is displayed in 
the window and the instrument beeps.

A summary of the standard data will be printed automatically; this summary does 
not contain the individual counts for each accumulation point.

If you wish to print the raw counts for each accumulation, choose Print in the X- 
Text window before you close this window. Although accumulation data may be 
viewed using Check Data after the X-Text window has been closed, the only 
convenient way to print it out the individual count data is to print the X-Text 
window. Once X-Text is closed, this information is not readily available for 
printing.
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To copy an existing standard composition to a new file:

Standard compositions will be copied to new files when the same standard is present on 
more than one standard block; or the same standard analyzed under significantly 
different conditions.

Menu: Utility ->File Utility ->Data Arrange -> Standard Data

Select an existing file to copy, assign a name for the new file and click on Copy. In 
order for this new file to show up on the list of possible standards, you must close and 
then re-open the standard analysis window if it has been open during this procedure.
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SECTION 9: Quantitative Analysis

Menu: Analysis -> Quantitative Analysis

After a few seconds, a menu bar will come up and must be placed by clicking the left mouse 
button.

Sample:

Choose a group by pressing the Group button and highlighting your choice on the list. If 
you are a new user, press New and set up a new group name. Choose OK. If the list of 
group names which appears is unfamiliar to you, you may be in the wrong directory. Reset 
the initial directory to use your own. (Initialize -> Change Directory. Type the path to 
your login directory: /users/vowr directory. If you are using the common-use directory, the 
appropriate path name here is /users/jxl.)

A menu of samples previously set up in this group (if any exist), the last date they were 
measured or updated, and whether data was measured using WDS or EDS analysis or both, 
will be displayed. Use the pointer to highlight the sample being chosen. To add a new 
sample, choose New, and you will be prompted for a new sample name. Click on OK 
when you are finished.

Measurement: If you are setting up a new analysis routinet skip to Correction Method, 

Condition Load:

If you already have an analytical routine set up and wish to repeat those previously 
designed and saved conditions for this analysis, choosing Condition Load will allow 
you to recall those conditions. See discussion of default analysis conditions in 
Section 16. A list of your previously saved condition files will be displayed; 
highlight the one you wish to use and click Load.

Check to make sure that the conditions set are those you want for this measurement, 
paying special attention to element conditions to make sure the most current peak 
position is in use. You must update the EOS Condition because only the condenser 
and objective lens settings are saved directly. The instrument will not adjust these 
settings to get the "correct" reading at the cup. Therefore, if filament conditions have 
changed since the analytical conditions were saved, those same lens settings may not 
produce the desired beam current. Therefore adjust the instrument conditions to those 
desired for analysis and choose Read in the EOS Condition window.

Correction Method: If you are using a preset condition and you have checked analysis 
conditions, you can skip to Stage Condition.

Quantitative Analysis -> Measurement -> Correction

Choose the correction method you wish to use for your analyses.

The ZAP correction was developed by JEOL (reference nos. 4-7, 9) "BandA" is the 
correction method of Bence and Albee (2), the PRZ method selects the following:

a) if Oxide is chosen, "PRZ" performs CITZAF matrix corrections of Armstrong (1).

b) if Metal is chosen, "PRZ" performs the XPP correction of Pouchou and Pichoir (8).
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Consult your lab supervisor if you have any questions about the available correction 
routines.

Element Condition:

WDS Elements:
Select elements to be measured in this sample using Wavelength Dispersive 
Spectrometry by clicking their symbols in the periodic table. Clicking an element 
more than once results in multiple analyses of that element. To clear existing 
elements, highlight them in the box below the table, then choose Clear. The 
order in which you choose the elements is the order in which they will be 
analyzed unless you change it in the WDS Condition window. Volatile elements 
(Na, K, F, etc.) should be measured on the first pass to minimize loss due to beam 
exposure.

WDS Condition:
Choosing this will display the current spectrometer settings for measuring the 
elements selected for WDS (wavelength dispersive Spectrometry) analysis. 
Clicking on the element box at the top of any element condition description will 
open a screen which displays alternative existing spectrometer analysis conditions 
for this element. (There should be a set of analytical conditions for each possible 
crystal on each spectrometer on which this element can be measured). You may 
choose to use one as it stands or to modify an existing set-up by changing 
counting times, peak search conditions, backgrounds, etc.

To make modifications, place the cursor over the area you wish to change and 
press the left mouse button; a window will appear in which you can alter the 
chosen value. Please do not alter the PHA (voltage, baseline and window) 
conditions without consulting a lab supervisor first. PHA settings for all 
elements must match the settings used during standardization for an accurate 
quantitative analysis.

When the conditions are satisfactory, highlight the box above the set of conditions 
you wish to apply and exit the screen by clicking OK. Do this for each element to 
be analyzed.

NOTE: In order to assure that the most up-to-date instrument settings are used 
for your analysis, it is wise to open this window for each element and click on 
OK, because parameters such as peak positions are automatically updated here 
but not in each user's condition files.

EDS Elements:
Choose elements for EDS analysis in this window, which functions the same way 
the WDS Elements window (above) are selected.

EDS Condition:
Only the x-ray line can be chosen. The other conditions will be the same as those 
set for the standards and cannot be changed here.

Calculation:
Elements chosen here will be calculated stoichiometrically instead of analyzed 
directly. Typically the dominant anion in your samples is calculated. If you have 
chosen the oxide correction method, oxygen is calculated by default.
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Calculation Condition:
Select from six modes of element calculation.

Valence: If the sample is to be analyzed as an oxide, click on Valence to open a 
window displaying default valences. Make any necessary changes and click OK.

EOS Condition:

This window summarizes the operating conditions to be used for analysis. Make sure 
the beam diameter is set to an appropriate size for the sample in question (adjustable 
in the EOS Monitor window). On the console control panel, turn the PRBSCN off 
and, with the PCD in, set an appropriate beam current (typically on the order of 2 x 
10"8 amps = 20 nanoamps). Choose Read to enter the current instrument conditions 
into this window, where they may then be modified if necessary. Click OK to save 
the conditions for automatic use during measurement. Choosing Set will set the 
instrument to the conditions currently displayed in this window.

EDS Condition:

This window displays the operating conditions for EDS. The options in this window 
should read as follows for Standard Analysis and Quantitative Analysis;

Energy Full Scale: 10
Spectrum Data Points: 1024 (default)
Measurement Mode: LIVE
Measurement Time: (has no effect)
Aperture: 1

The aperture setting in the software bears no relation to the actual aperture setting of 
the detector. The aperture must be adjusted manually to a setting that will keep the 
dead time of the EDS detector between 20 and 40%. If the dead time is too low, not 
enough counts are reaching the detector, but if the dead time exceeds 40%, the 
detector is being swamped and missing too many counts. If both EDS and WDS 
analyses are being done, the beam current should be adjusted for WDS (e.g. 20nA) 
and then the aperture should be adjusted to yield 20-40% dead time. It is strongly 
advised that you discuss the EDS aperture setting with the laboratory supervisor 
before doing EDS quantitative analysis.

Standard Conditions:

Check to make sure that the standards you want are the ones selected for this analysis. 
If you wish to change a standard, click the button above the element and select the 
desired standard from the list presented. If no standard has been measured under your 
measurement conditions, the only available choice will be "calculated".

The button in this window which says "set standards meas. ON" will turn on the 
standards chosen here for use in standard analysis, preset measurement. If the 
standard you want to use is not on the list, then probably it was standardized on a 
different spectrometer or crystal than what you have selected.

Either change your element conditions to that of your standard or go back to Analysis 
-> Standard and re-standardize using the conditions you have set up for this analysis. 
Note that the standardizations can be changed after the analysis using Process -> 
Quantitative -> Off-Line Correction as described later in this section.
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Stage Condition:

This window is used to set stage position coordinates for the points to be measured. If 
positions have already been set for this sample, they will be displayed. Point Table 
Edit can be used to edit existing points; this can be especially helpful if you need to 
edit comments. Highlight an existing position to confirm or modify it, or highlight 
the next available empty position to add a new point. Select Pos. Input and a 
window with an image of the stage will appear.

To enter new positions:

1. To move the stage into position, click to indicate the approximate position on 
the stage with the pointer and select Move or use the joystick to move to the 
point of interest.

2. Focus the image optically using the Z-axis controls on the joystick. Always 
focus the cross-hair by using the up arrow last so that the backlash is taken out 
of the gears and the computer will return to that position more precisely. Press 
TEST on the joystick to check the focus and X and Y position. If any 
coordinate is off, correct and test again until satisfactory. Good optical focus 
is critical for an accurate analysis.

3. Click Read and then Store in the window, or press the STORE button on the 
joystick to enter this as a stage position for measurement on this sample. If 
you use the STORE button on the joystick console, you will then have to press 
REQ to reactivate the joystick.

4. For more than one accumulation, click the Accumulation button and type in 
the number or slide the bar to the desired number, then click OK. The 
accumulation function will average all the points selected and the individual 
point analyses will be lost. This is not recommended for quantitative analysis, 
since data can be averaged later using the off-line summary function.

To set positions for the accumulations click Confirm; a small window will 
open and remain open until a position is stored for each accumulation. On the 
joystick console choose a point to be measured, focus, choose TEST to 
remove stage motor backlash, then re-focus if necessary.

When satisfied with the focus and the position, press STORE to store that 
position as an accumulation point to be measured. A tone will sound and you 
can move to the next position and repeat the procedure until all the 
accumulations are set. After the last point is set, the instrument does not beep, 
instead the accumulations window disappears and the joystick is deactivated.

5. Edit the comment line if necessary by placing the cursor in the box and typing.

6. Click on Apply to store the information for this point unless you have used the 
STORE function on the joystick control (see step #3).

7. Use the arrows at the upper right of the stage window to highlight the next 
blank line or move to the next point you wish to modify. The information on 
the currently highlighted line will be overwritten the next time you choose 
Apply, so it is important to remember to use the arrows to advance to the next 
line.
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Repeat steps 1-5 until all points have been entered or modified. Click on 
Close to close the stage window. The data in this window is saved 
automatically when the window is closed. Until a Save button is added to the 
stage position window in quantitative analysis, the user should close the stage 
window periodically so that the data will be saved to the hard disk. Otherwise 
your position data is at risk if the software fails. Once a Save button is added 
to the window, simply click on Save periodically for the same reason.

To modify existing positions:

1. Choose Pos. Input from the Stage Condition window.

2. Select Confirm. The stage will automatically be positioned at the point set for 
the first accumulation. You may move to a different position or adjust the 
focus of this position or make no change at all. Press STORE. The stage will 
automatically drive to the position previously set for the next accumulation.

3. The sequence described in (2) will continue until all the stored positions have 
been checked. When you are satisfied with the positions chosen, click on 
Apply, then on Close.

After the Position Input window has been closed, you may choose One-by-One if 
you only want the highlighted position to be analyzed at this time. Press Acquire in 
the window that appears and an analysis will be performed for the highlighted point 
only. If you have set up a number of measurements to be done automatically, choose 
all the points you wish to analyze by clicking the buttons to the left of their numbers 
in the Stage Condition window (blue=ON). Close this window when all the points 
have been selected. Select Preset Measurement in the measurement menu, and click 
Acquire. All the points selected will now be analyzed in turn.

Print-out Condition:

This window allows you to choose the order in which the elements are printed, full or 
brief print-out, and other features of the output. Full output is preferable. You also 
set the number of oxygens used in the mineral formula calculation (cations) mode 
from this window.

Condition Store:

If you are happy with the conditions as they are set up, and might want to use the 
same conditions again, save them here with a recognizable name. If this is done, you 
can retrieve them later using Condition Load.

Measurement Mode:

If both EDS and WDS analyses are being done, choose whether to do them at the 
same time (parallel) or separately (serial). If they are to be done separately choose the 
order in which they should be accomplished. If using parallel mode, be advised that 
EDS peaks will broaden due to noise from the WDS spectrometer motors.

Survey Measurement:

Choose this process to take a quick measurement of the point under the beam to check 
the conditions you have set up. Data measured here will be stored as point #9999
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under the present Group/Sample, and will be overwritten the next time a survey 
measurement is done. Thus only the last survey analysis will be saved to your data 
files.

Additional Functions:

In this window you can choose whether to do background measurements and peak 
searches on all measurements, not at all, or every ntn measurement. Peak seeking is 
recommended to overcome any spectrometer or crystal-flipping backlash, except for 
volatile or minor elements. If minor elements are being measured (i.e., low count 
rate and unsuccessful "peak-seek"), peak-searching is automatically disabled and the 
default peak position is used. If it is possible to mistakenly pick up a nearby peak, 
peak searches are not recommended. Background measurements are recommended if 
phases are heterogeneous or zoned and if minor element measurements are important.

Pre-set Measurement:

As described in the section on setting stage positions, when all the points have been 
entered, selecting this menu item and choosing Acquire will cause the designated 
points to be analyzed automatically.

If you are doing EDS measurements, the EDS window must either be open or present 
on the screen as an icon while measurement is occurring or an error will cause 
measurement to stop. Hopefully this problem will be solved with a software upgrade.

As with standard analysis, while an analysis is occurring, a small window will be 
open showing a moving pump, and keeping you informed about how many 
accumulations have been completed, etc. This window will close when the analyses 
are complete. To stop the analyses at any time click the Accum Stop or the Stop 
button in this window and the measurement will end abruptly. By clicking on Stop 
one runs the risk of temporarily disabling the software or losing communication 
between the instrument and the workstation. If this happens, please refer to the 
appropriate Troubleshooting sections of this manual and/or consult a lab attendant.

Data appears in a window labeled "X-Text" as measurements are taken. When an analysis 
is complete, a message to that effect shows in the window, and the instrument beeps. At 
the end of a preset group of analyses, the instrument will beep three times.
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SECTION 10: Line Analysis

Menu: Analysis -> Line Analysis

This function is useful for qualitative "traverses" of element compositions in samples, or for 
setting up points for a quantitative line traverse. Many options for line analysis are similar to 
items in the quantitative analysis menu, so are described here only briefly. Refer to Section 
9, Quantitative Analysis for more complete information.

Sample:

Choose a group by pressing the Group button and highlighting your choice on the list. 
If you are a new user, consult Section 9, Quantitative Analysis, or laboratory personnel. 
To add a new sample, choose New, and you will be prompted for a new sample name.

Select OK when you are finished.

Measurement:

Condition Load:

If you wish to duplicate a previous run for which you stored the conditions, select 
the stored condition file in this window and click on Load. There is more 
information about loading stored conditions in Section 9: Quantitative Analysis; a 
discussion of default analysis conditions in Section 16 is also applicable.

Element Condition:

Element:
Select elements for analysis by clicking their symbols in the periodic table. 
Pressing an element more than once results in multiple analyses of that 
element. To clear existing elements, highlight them in the box below the 
table, then choose Clear. The order in which you choose the elements is the 
order in which they will be analyzed.

Condition:
This menu option will display the current spectrometer settings for measuring 
the elements selected for this sample. Clicking on the element box at the top 
of any element condition description will open a list of alternative 
measurement conditions for this element. (There should be a column of data 
for each possible crystal on each spectrometer on which this element can be 
measured).

You may choose to use or modify an existing set-up, or create a new one. To 
make a modification, click in the box of the item you wish to change and 
make your selection from the list presented. To create a new set-up, click 
New and then modify the default conditions as above.. The eight items in the 
list from Back(+) to Bac Count are ignored in line analysis. In particular, 
counting times set here do not apply to line scans, since the dwell time per 
pixel is set under Stage Conditions. Highlight the box above the set of 
conditions you wish to apply and exit the screen by clicking OK. Do this for 
each element to be analyzed.
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IMS Signal:
Open this box to choose the signal type for measurement: SEI (secondary 
electron), TOPO, or COMP (back-scattered electron). AUX has no meaning.

EOS Condition:

This window summarizes the operating conditions to be used for analysis. Make 
sure the beam diameter is set to a proper size (this is related to the measurement 
interval, which is discussed under Stage Condition).

Turn the PRBSCN off, and with the PCD in, set an appropriate beam current 
(typically on the order of 2 x 10'8 amps = 20 nanoamps). Choose Read to enter 
the current instrument conditions into this window, where they may then be 
modified if necessary. Click OK to save the conditions for automatic use during 
measurement. Choosing Set will set the instrument to the conditions currently 
displayed in this window.

EDS Condition:

Refer to Section 9, Quantitative Analysis for an explanation of proper EDS 
settings.

Stage Condition:

This function is used to assign stage position coordinates for the line analysis. If a 
line has already been set, its end points are displayed in this window. Highlight 
an existing line to confirm or modify it, or highlight the next available empty 
position to add a new line. Choose Pos Input and the stage window will appear.

To enter lines:

1. To move the stage to the proper position, click on Move if the previously 
stored position is appropriate. Otherwise, either click on the approximate 
position and choose Move, or use the joystick to move to the sample of 
interest. Focus the image optically.

2. Edit the comment line if necessary.

3. Choose to move either the stage or the beam during the scan. A stage scan 
allows a larger area to be covered than a beam scan.

4. Choose normal or micro step size. Normal is appropriate unless a very small 
area is under study.

5. Use Accumulations to set the number of times the scan is to be repeated. 
Note that the accumulations will be averaged together to give one analysis.

6. Choose an appropriate dwell time for each point analyzed. This parameter, in 
combination with the number of pixels to be measured and the accumulations 
will determine how long the analysis will take. The time estimate given is 
approximate.
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Method 1:
Set a position, direction, number of pixels (points), analysis interval

  After choosing a location, select Read, then Store to enter this as the 
initial stage position for measurements on this sample. Choose whether 
this point is to be the beginning, the mid-point, or the end of the line.

  Choose the number of pixels up to a maximum of 1024.

  Highlight the appropriate arrow on the display to choose the direction you 
want the line to go. The arrows correspond to the electron image, which 
means that x is the reverse of the optical image but y is the same.

  Set XY Size, (the measurement interval in microns)

Method 2:
Set the beginning, end, and distance between points

  After choosing a location select Read, then Store as the beginning of the 
line.

  Move to the position where you want the line to end and focus. Select 
Read, then Store as the end of the line.

  Set XY Size (the measurement interval in microns).

7. To check the line to be mapped, choose Confirm. The sample will be
positioned at one end of the line. Focus, choose TEST to remove stage motor 
backlash, then re-focus if necessary. When satisfied with the focus and the 
position press STOR on the joystick controller, The sample will then be 
positioned automatically at the other end of the line; repeat the focusing 
procedure.

8. Choose Apply to store the information. A new blank line will open in the 
parent window; use the arrow at the upper right of the stage window to 
highlight the new line and repeat the above steps to define another line.

9. If you want to do quantitative analysis at each point of a line you have defined, 
you can choose Convert to Point table. This will convert your line points 
(up to a max of 9999) to points in the quantitative analysis table (Analysis -> 
Quantitative -> Measurement -> Stage Conditions) under the same sample 
name you have chosen for the line, creating it as a new sample name for 
quantitative analysis if necessary.

The conditions for the analysis must be set in the Analysis -> Quantitative 
menu; only the point coordinates are transferred from line analysis to 
quantitative analysis.

10. Choose Close when you have finished defining lines.

After the stage window has been closed, you may choose One-by-One, then 
Acquire, to analyze only the highlighted line at this time. If you are setting up a 
number of measurements to be done automatically, define all the lines, select the 
ones to be analyzed by clicking the button at the left of the desired lines
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(blue=ON), then close the stage window and choose Preset Measurement from 
the Measurement menu. Click on Acquire to start your analyses.

Print-out Condition:

Choose to print out measurement conditions and results. 

Condition Store:

If you might want to use the same conditions again at a later date, save them here. 
You can then retrieve them at any time with the Condition Load command.

Survey Measurement:

This will execute a single line scan measurement. Unfortunately, data is written 
in position #9999 of the current Group/Sample, which means that each successive 
survey measurement will overwrite the previous analysis data, and there is no way 
to recover the data once that happens. The print-out is the only record you will 
have for any survey analyses except your final survey analysis.

Pre-set Measurement:

When all lines on all samples have been chosen and entered as above, choose 
Acquire to start the analyses. A small window will be open showing a moving 
pump and keeping you informed about how many accumulations have been 
completed, etc. This window will close when the analysis is complete. To 
interrupt the analyses, choose Accum Stop or Stop in this window.

Viewing Line Scans:

To view the analysis on the screen as it is happening select Analysis -> Line Real- 
time. Select the proper sample using the Sampie button, then click on Real-Time to 
start the display.

To recall or reprocess line analyses after they have been acquired, select Process -> 
Line Analysis. Choose the appropriate group name, highlight the analysis of interest 
and a list of stage positions for that line analysis will appear. Highlight the desired 
stage position, then choose which elements (up to 5) you wish to display on the screen. 
Clicking the Max Spectra button opens a window where the number of spectra to be 
displayed is chosen. When you are ready, choose OK and be patient, as the loading 
process takes a while, but eventually the appropriate scans will appear on the screen. 
Clicking the mouse or pressing the keyboard while the files are loading may lead to 
system lock-up.

When the spectra are displayed, the Spectra Specify window is also opened. Click on 
the element to be processed, then click on the Operation button to open a menu of 
available processing operations.

The display can be manipulated using the options found under Spectra Display. 
Choosing Spectra Analysis allows examination of x-ray intensity or concentration for 
points on the line. The Spectra Calculation menu accesses arithmetic operations 
which can be performed on the spectra.
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Calibration Factor allows specification of factors for use in converting intensity to 
concentration (instructions for evaluating the calibration factors are given in the 
description of map analysis).

Reset Display releases all the processing and restores the display to the original data. 
There is more information about these options in the JEOL software manual..
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SECTION 11: Map Analysis

Menu: Analysis -> Map Analysis

Many options for map analysis are similar to items in the quantitative analysis menu, so are 
described here only briefly. Refer to Section 9, Quantitative Analysis, for more complete 
information.

Sample:

Choose a group by pressing the Group button and highlighting your choice on the list. If you 
are a new user, consult a laboratory supervisor before proceeding. See Section 9 for 
information on setting up a new group directory. To add a new sample, choose New, and you 
will be prompted for a new sample name. 
Select OK when you are finished.

Measurement:

Condition Load:

If you created and saved analytical conditions for a previous map and wish to use 
those conditions again, select the stored condition file and choose Load. There is 
more information about loading stored conditions in Section 9: Quantitative 
Analysis; a discussion of default analysis conditions in Section 16 is also applicable.

Element Condition:

Elements:
Select elements to be measured by clicking their symbols in the periodic table. 
Selecting an element more than once results in multiple analyses of that 
element. To clear existing elements, highlight them in the box below the table, 
then choose Clear. The order in which you choose the elements is the order 
in which they will be analyzed.

Condition:
Choosing this will cause the current spectrometer settings to be displayed for 
measuring the elements selected. Clicking on the element box at the top of 
any element condition description will open a list of alternative measurement 
conditions for this element. (There should be a set of analysis conditions for 
each possible crystal on each spectrometer on which this element can be 
measured.) You may choose to use or modify an existing set-up, or create a 
new one. To make a modification click on the item you wish to change and 
make your selection.

To create a new setup, choose New and modify the default conditions which 
appear. The eight items on the list from Back(+) through Bac Count are used 
only for quantitative and standard analysis and have no meaning here. 
Highlight the box above the set of conditions you wish to apply and exit the 
screen by clicking OK. Try to minimize the number of elements per 
spectrometer (sequence number ideally should be 1) as the total analysis time 
for making a map is a function of this sequence number.
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IMS Signal:
Open this box to choose the signal type for measurement: SEI (secondary 
electron), TOPO, or COMP (back-scattered electron). AUX has no meaning. 
You may choose more than one signal type, but be aware that two signals will 
double your analysis time...three will triple the time.

EOS Condition:

This window displays the Electron Optical System conditions to be used for 
analysis. Make sure the beam diameter is set to an appropriate size. For 
maximum resolution, the probe diameter should be less than the pixel size. For 
pixel sizes less than 5 microns, the probe diameter should be 0 (see Stage 
Condition, step 7). Turn the PRBSCN off and, with the PCD in, set an 
appropriate beam current (typically 5 x 10 '8 amps, or 50 nanoamps are used for 
map analysis in order to increase the signal).

Choose Read to enter the current instrument conditions into this window, where 
they may then be modified if necessary. Click OK to save the conditions for 
automatic use during measurement Choosing Set will set the instrument to the 
conditions currently displayed in this window.

EDS Condition:

See Section 9, Quantitative Analysis, EDS Condition, for a discussion of proper 
EDS quantitative analysis conditions. Consult lab personnel before using EDS for 
map analysis or quantitative analysis.

Stage Condition:

This item is used to assign stage position coordinates for the area to be measured. 
If areas have already been set, their limits are displayed. Highlight an existing 
area to confirm or modify it, or highlight the next available empty position to add 
a new area. Choose Area Input and the stage window will appear. 
To enter areas:

1. To move the stage to the proper position, click on Move if the previously 
stored position is appropriate. Otherwise, click on the approximate 
position on the stage and choose Move, or use the joystick to move to the 
area of interest. Focus the image optically.

2. Select Read, then Store to enter this as the initial stage position for 
measurement of this area. Choose whether you want this position to be 
the center of the desired area, the beginning (upper right corner) on the 
CRT image, or the end (lower left corner) of the area.

3. Edit the comment line if necessary.

4. Choose to move either the stage or the beam during the scan. A stage scan 
is usually appropriate and allows a larger area to be measured. Beam scan 
should be used for magnifications >2000X or with EDS only. A 
unidirectional stage scan (Stage(uni)) minimizes the influence of backlash 
and stage alignment problems without increasing measurement time 
considerably.
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5. Use Accumulations to set the number of times the scan is to be repeated. 
The accumulations will be averaged together to give one analysis; 
therefore one is the normal value.

6. Choose an appropriate dwell time. This parameter, in combination with 
the number of pixels to be measured and the number of accumulations 
chosen, will determine how long the analysis will take. The time estimate 
given is approximate.

7. Choose the number of pixels in each direction and the pixel size desired. 
There is a maximum of 1024 pixels in either direction. The pixel size 
(microns) should be larger than the probe diameter (see EOS Condition 
above). These two parameters determine the size of the area to be 
mapped.

8. To check the area to be mapped, choose Confirm. The stage will be 
driven to each corner of the area in turn. At each corner the focus must be 
set using the joystick console z-axis controls. Choose TEST to remove 
stage motor backlash, then re-focus if necessary. When satisfied with the 
focus and the position press STOR button on the joystick control. The 
stage will automatically move to the next corner.

If the area is not satisfactory, reset the reference point (center or beginning 
or ending corner) or adjust the number of pixels and their size, then repeat 
this step.

9. Choose Apply to store the information. A new blank line will open in the 
Stage Condition window; use the arrow at the upper right of the stage 
window to highlight the new line and repeat the above steps to define 
another area.

10. If you want to do quantitative analysis at each point of an area you have 
defined, choose Convert to Point Table. This will convert your map 
points (up to a maximum of 9999) to points in the quantitative analysis 
table (Analysis -> Quantitative -> Measurement -> Stage Conditions) 
under the same sample name you have chosen for the area, creating a new 
sample name for quantitative analysis if necessary. The conditions for the 
analysis must be set in the Analysis -> Quantitative menu; only the point 
coordinates are transferred from map analysis to quantitative analysis. If 
you are tempted to use this technique, remember that a 100x100 pixel area 
is 10000 points, and with typical analysis times greater than one minute, it 
would take several days to quantitatively analyze the area, even if the 
Stage Condition files could store that many positions.

11. Choose Close when you have finished defining areas.

After the stage window has been closed, you may choose One-by-One to 
analyze only the highlighted area. If you are setting up a number of maps to 
be done automatically, choose the maps to be measured by clicking their 
button (blue=ON), then close the stage window and choose Preset 
Measurement from the Measurement menu. Choose Acquire to start your 
analyses.
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Print-out Condition:

Choose to print out conditions for measurement and results. 

Condition Store:

If you wish to save your measurement conditions for possible later use, do so in 
this window. Your conditions can then be retrieved at any time using Condition 
Load.

Survey Measurement:

If you wish to get rough results, you only need to open the Stage Conditions 
window and set the scan type, dwell time, pixels and pixel size. The current 
instrument conditions will be used to carry out a rough measurement, which will 
be stored as #9999 in the current Group/Sample. If you wish to preserve the data 
in a more accessible form, use the Pre-set Measurement option.

Pre-set Measurement:

When all areas on all samples have been chosen and entered as above, choose 
Acquire in this window to start the analyses. While measurement is occurring, a 
small window will be open showing an active pump moving, and keeping you 
informed about how many accumulations have been completed. Choose Stop or 
Accum Stop in this small window to interrupt the analysis.

Viewing Maps:

To view the analysis on the screen as it occurs select Analysis  > Map Real-time. To 
enter calibration factors to relate the map colors to composition rather than counts, 
choose Operation -> Map Display -> Level Modify within the real-time map display 
window. See below for information on how to obtain calibration factors.

To recall or re-process area analyses select Process  > Map Analysis from the EPMA 
Menu. Choose the appropriate group name, highlight the analysis of interest, and the 
window will display the stage position and the elements for which the analysis was 
done. Choosing Max Maps in this window allows you to set the display for the 
number of maps you wish to see on the screen and the number of colors. The more 
maps you display, the fewer colors you may use. If you choose too many colors, you 
will get an error message to that effect when you try to close this window.

Highlight the elements for which you want maps displayed in the order desired, press 
OK, and be patient because the loading process takes a while. Eventually the 
appropriate scans will appear on the screen. Choosing Operation -> Calibration 
Factor here will allow you to enter factors to relate the map colors to element 
concentrations rather than counts. See below for information about how to obtain 
calibration factors. For a description of other processing options, see Section 10: Line 
Analysis or refer to the chapter on Map Analysis in JEOL Instructions.
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To Get Calibration Factors A and B for Data Conversion from Intensity to 
Concentration:

Menu: Analysis -> Standard -> Measurement -> Standard Type

Choose Calibration Curve, then click OK. 

Menu: Analysis -> Standard -> Measurement -> Check Data

A calibration line will be displayed, with values for A and B. According to the 
JEOL Instructions manual,

A = X-ray intensity per 1% concentration, in units of 
counts/((microamps)(microseconds)%);

B = background, in units of counts/((microamps)(microseconds)).

Choose Element to display a window with A and B values for all the elements 
analyzed on this standard. In the Element window, choosing A or B will allow 
you to adjust the value manually.

Choosing Name will make each standard name into an active button; choosing 
one of these buttons will bring up a display showing cps/nanoamp for this 
analysis. Choosing Search in this window brings up yet another window where 
an element name can be entered, and a list of the standard names which have 
analyses for that element will appear, along with information about the analysis 
such as kV, channel, crystal, cps/nanoamp. This window is informational only... 
choosing an analysis here by clicking its button has no effect on anything else.

Menu: Analysis -> Standard -> Measurement -> Standard Type

Turn off the Calibration Curve toggle when you are through, as it interferes with 
some of the other functions in standard analysis.
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SECTION 12: Serial Auto Analysis 

Menu: Analysis -> Serial Auto Analysis

Serial Auto Analysis enables you to schedule a number of analyses requiring different 
analytical conditions to be run in one unattended session. The analysis order, along with 
some information about each analysis already chosen for inclusion, is displayed. Below is 
a brief recommended procedure followed by a more complete description of each menu 
option.

Recommended Procedure:

1. Before coming to Serial Auto Analysis, set up each individual analysis package in the 
usual way (under Quant, Line or Map) and save a condition file for each package you 
set up using Condition Store.

2. In the Serial Auto Analysis window, choose File -> Open Serial Directory. Either 
choose one of your previous series set-ups to modify or enter a new name for the 
series you are about to set up.

3. Choose Condition -> Input Condition or click on the Input button to open the Input 
Condition window.

4. For each analysis you wish to place in the series:

  Choose the appropriate analysis type: map, quant, line, etc.

  Click on Group/Sample and choose the group and sample name for the analysis 
as you set it up in step 1.

  Choose Condition Load. In the resulting window, choose to load from stored 
condition files, then highlight the name of the condition file you set up in step 1 
for this analysis and click OK.

  Choose Apply, then use the arrows at the top of the Input Condition window to 
move down to a blank line. Repeat the sequence in step 4 for each analysis you 
wish to place in the series.

5. Measurement -> Preset.

Serial analysis creates one file for each analysis in the series in a special directory under 
your user name. Into each file is copied the set of conditions which you indicated (by 
doing a Condition Load) should be used for this analysis.

Changes to conditions made in the Serial Analysis window do NOT modify the original 
condition file, only the copy of that file which will be used to direct the serial analysis. By 
the same token, changes you make to the original condition file by going back to the 
original analysis menu (Quant, Map, Line) will not be transferred to your serial analysis 
set-up unless you specifically re-load those conditions to the serial analysis after making 
the changes.
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File Menu:

Open Serial Directory:

Give your serial analysis file a name in this window or choose a previous series to 
modify.

Printout:

Print out the serial setups to be used and the analysis order. 
Condition Menu:

Input Condition:

The Input button in the Serial Analysis window is equivalent to choosing Condition 
-> Input Condition. A window will open where one chooses the analysis type 
(Quantitative Analysis, Map Analysis, etc.) and the analysis conditions (EOS 
conditions, elements, etc.) for whichever analysis in the sequence is currently 
highlighted in the parent Serial Analysis window.

Measurement type:

Click the type of measurement this analysis in the sequence will be. 

Condition load:

Choose either to accept the present configuration of the instrument (i.e., the 
most recent conditions used for this type of measurement, which will not be the 
most recent conditions for this type of measurement for this sample if that was 
not what you were doing last) or to load a set of stored conditions. If you 
choose to load stored conditions, a list of your stored condition files for this sort 
of measurement will be displayed for you to choose from.

Condition change:

A window will open allowing you to choose which conditions to examine 
and/or change. You can only examine Element conditions. Choosing EOS 
Conditions, EDS Conditions or Standard Conditions will open windows 
similar to those presented when you set up the analysis as an individual analysis, 
and most of those items can be modified here. Be aware, however, that you are 
modifying them for the serial analysis only, and changes you make here will not 
carry back to your condition files stored under the individual analyses.

Group/Sample:

This button presents you with a display of the groups and sample names you 
have set up for this kind of measurement. Click on the analysis you are 
choosing for this position in the series of analyses.
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Stage Condition:

Clicking this button will open the familiar stage condition window where you 
can choose which points to include in your analysis and you can re-position or 
re-focus existing points as well as add new ones.

Check:

This option allows you to review all relevant analysis conditions. They cannot 
be changed in this window, but can be printed out.

Apply:

Clicking here will save the conditions you have just set up for use with the 
analysis which is highlighted in the sequence window. If you try to exit the 
Input window without applying, or if you use the arrows in the upper right 
corner of this window to move to set up another analysis without having chosen 
Apply first, you will be prompted to save the conditions you just chose.

Copy, Move, Delete, etc.:

These are basic operations which can be used to modify the order of analysis. They 
are fairly self-explanatory.

Measurement:

One-by-one runs the highlighted analysis routine only.

Preset runs all the analysis routines which have been selected (marked with a blue box).

To get a summary of the data gathered using Serial Auto Analysis, use the appropriate Process 
menu for each individual analysis type used in the series. There is no separate compiled summary 
file for Serial Auto Analysis.
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SECTION 13: EDS Analysis 

Menu: EDS-> EDS

The following commands are found in the main EDS window: 

Two boxes w/an arrow between them:

This function clears previous spectra and should be used before every spectrum 
acquisition.

Acq. Spectrum:

Clicking this button toggles EDS acquisition on and off. The analysis will stop 
automatically and the beam will be blocked after the counting time set under 
Preset.Preset: This function allows the user to choose a set counting time, analysis 
time and regions-of-interest (ROI). If the time is set to zero, counting will continue 
until it is turned off by clicking again on the Acq. Spectrum toggle.

ROI:

(Region Of Interest) This allows the user to highlight a region of interest and 
determine integrated counts between samples in that energy range. To set, click on 
ROI and move the red lines on the spectrum with the arrow keys in the ROI sub- 
window. Multiple ROIs can be set, and the ROI Integral window will display data for 
all of them. It is necessary to set regions of interest when using EDS for quantitative 
analysis.

Analysis:

Peak ID:
This gives possible peak identifications for the current cursor position.

Auto. Idem.:
This function identifies peaks in the EDS spectrum display.

Quantitative Analysis:
This window displays analysis conditions for quantitative analysis.

F (Spectra Calc.):
This window displays options for mathematical manipulation of EDS data.

Periodic Table:

Peaks can be identified by guessing with the Periodic Table keys. Clicking on an 
element when Peak Label is ON causes lines coinciding with the expected peaks and 
the element name to appear at the appropriate positions. Always Analyze keeps the 
peak labels up as other elements are selected so that multiple peak positions can be 
seen at once. To clear the spectra of unwanted peak labels, click on Analyze if 
Found and then on the elements in colors other than blue. The element button will 
turn blue, and the peak label will disappear from the spectrum. Turning the Peak 
Label OFF will prevent the element name from appearing on the spectrum when the 
element is clicked on in the table.
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The Auto Ident key is non-functional and misleading in the Periodic Table window. 
To identify an unknown peak, put the cursor on the peak and click, click on the 
Analysis button in the main EDS window, and then choose Peak ID or Auto Ident.

Print:
This is intended to print the spectra on the dot matrix printer.

1234:
This window displays conditions and comments for EDS measurements. It also 
allows for temporary storage of up to four EDS spectra and their conditions. The 
highlighted number indicates the set-up in use and spectrum currently displayed.

Parameter List:
The parameters listed here are the analysis conditions for scans 1, 2 ,3 and 4.

Data Management:
This allows for storage and saving of conditions and spectra.

Vertical/Horizontal scale:
These controls let the user zoom in and out on an energy range by clicking on the 
appropriate arrow buttons.

Cursor:
This function moves the cursor in the home window. However, it is simpler to move 
the cursor by clicking directly at the desired spot.

Net/Gross:
This is a toggle between spectra types. The spectra options are Net (background 
corrected) and Gross (the same as in the small window).

Display Mode:
This lets the user to manipulate the display (colors, etc.).

Analyzer:
This window displays the detector conditions of the EDS system and allows the user 
to manipulate them. Most of these conditions should only be changed by someone 
who knows what they're doing (like a JEOL engineer). The only thing routinely done 
by users in this window is to toggle between Bias on and Bias off in response to a 
common error message saying that the gun bias is off.

Aperture #:
The aperture should always be left on #1. See Section 9, Quantitative Analysis 
for the proper setup of EDS analysis conditions..

Using EDS for Qualitative Analysis on Preset Points :

It is possible to preset multiple points and analytical conditions for qualitative EDS 
analyses by choosing Analysis->EDS Qualitative Analysis.

Sample:

Choose group and sample names as in quantitative analysis (Section 9).
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Measurement: 

EDS Conditions:

Set the following conditions for EDS analysis:

Els keV: Set the energy range that you are scanning.

Mode: Choose whether to measure for a fixed real time or live time (detector live time 
as inferred by the dead time bar at the side of the spectrum-approximately 70% of 
real time).

Seconds: Set the acquisition time.

Aperture: Use #1. Refer to Section 9, Quantitative Analysis, EDS Conditions for 
explanation.

EOS conditions:

This is the same window as in quantitative analysis, and it summarizes the Electron 
Optical System conditions to be used for the analysis. Refer to Section 9: 
Quantitative Analysis for details.

Stage position:

As in quantitative analysis, this window allows the user to set the stage for the points 
to be measured. Proceed as described in Section 9: Quantitative Analysis.

Preset Measurement:

This window also works the same way as in Quantitative Analysis. Make sure the 
positions you want to measure have all been selected (buttons in Stage Condition 
window are blue) and click on Acquire to begin analyzing.
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SECTION 14: Qualitative WDS Analysis 

Menu: Analysis -> Qualitative

This function is used for obtaining WDS spectra, similar to EDS spectra, of elements present 
in a sample.

Sample Button:

Choose your group and sample as described in Quantitative Analysis (Section 9). 

Measurement:

Condition Load:

If the spectrometer conditions from a previous run have been saved, they can be 
recalled by choosing Condition Load and highlighting the desired qualitative 
analysis condition file, then clicking on Load,

Spectrometer Condition:

This window displays the measurement conditions for the spectrometers. To alter 
the conditions, click directly on the desired setting value. Values for the 
measurement starting and ending positions can either be set directly or by element 
designation.

To use element designation, click on the Elem- box at the bottom of the condition 
list for the spectrometer of interest and a window containing a representation of 
the periodic table will appear. Click on the Order button in this window if it is 
necessary to set the order of the lines. Use the Line button to specify which line 
type. Click on the desired elements, and the measurement range will be set to 
include all x-ray and background analysis positions for these elements.

All elements can be chosen simultaneously by clicking on the All Elem button. 
Clicking on the Back (+) or Back (-) button allows you to change the 
measurement range for the peak position. Click OK when everything is set 
properly.

EOS Condition:

This is the same window as is used in Quantitative Analysis (see Section 9), and 
is used to set the electron optical system conditions for use during measurement.

Stage Position:

This functions in the same way as it does in Quantitative Analysis. Refer to 
Section 9 for details about how to set points for measurement.

Condition Store:

This option allows you to save the conditions used for this analysis (especially 
spectrometer conditions) for use again later. Give the file an appropriate name 
and choose Store.
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Print-out Condition:

Choose items to be included in your printed output. 

Survey Measurement:

A measurement will be performed at the current instrument settings and the 
results stored at position #9999 for the current Group/Sample.

Preset Measurement:

Measurements will be performed using the measurement conditions set in the 
EOS Condition window for all the points chosen in the Stage Position window.

Real-time Display of Spectra:

Choosing Analysis -> Qualitative Realtime will allow you to watch the analysis as it is 
occurring.

Realtime:

This will open a window where you can choose conditions for the live display, 
such as the number of spectra to display and the order in which to display them. 
Choose Start to begin the realtime display, Stop to stop it.

Sample:

This can only be used after the realtime display has been stopped, and will allow 
you to display spectra previously collected for a different sample. Enter the 
sample name for which you wish the spectra to be displayed.

Operations:

These operations can also be used only after the realtime display has been 
stopped:

Change Spectrum Pattern:
Choosing this will allow you to change the scale, color and format (vector, 
dot, bar) of the spectra.

Display Parameter:
Change the display items and the abscissa units for the parameters at the right 
of the realtime display window.

KLM Marker:
Labeled markers will appear on the spectra at the positions of the 
characteristic x-rays for the chosen elements.

Peak ID:
In this window, choose the spectrum of interest, then click with the cursor 
positioned on peaks in that spectrum, and the names of the characteristic x- 
rays in the vicinity of the pointer will be displayed.
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Spectra Calculation:
A variety of calculations such as smoothing, background subtraction, etc., are 
available through this menu choice.

Write Text:
Characters may be written in the spectrum display area.

Reset Spectra:
Restores spectrum to the state in which it was originally displayed.

Print-Out:
Choose items to print.

Processing Qualitative WDS Spectra: 

Menu: Process -> Qualitative 

Sample:

Choosing this will open a window listing the samples available in the current 
group. The group name can be changed by choosing Group in this window. 
Highlight the sample name of interest, and the available stage positions will be 
displayed. Highlight the stage position, and a list of available spectra will be 
shown. The number of spectra to be displayed is changed with the Max Spectra 
button; highlight the spectra of interest and click on OK, and the spectral data will 
be displayed in the data display window.

Operations:

This button accesses a number of possible processing operations which are 
described more fully in the JEOL Basic Software notebook in the Qualitative 
Analysis chapter.

Spectra Display:
Set zooming windows, normalization factors, horizontal and vertical scales. 
Change spectrum color, type (vector, dot, bar) and parameters on display at 
the right of the spectrum. Add text, or arrange to display multiple spectra to 
illustrate points of similarity or difference.

KLM Marker:
Add markers to the display for characteristic x-rays for chosen elements.

Peak ED:
Display names of characteristic x-rays for chosen peak positions.
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Off-Line ID:
Display names of existing elements at the corresponding peak positions on the
spectra. Choose Apply to save these.

Spectra Calculation:
A variety of mathematical operations are available for application to the 
spectra (smoothing, background subtraction, etc.).

Reset Spectra:
Release processing executed in the Operations menu and restore the settings 
to the original state.

Print-Out:
Choose data for printing.
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SECTION 15: Data Management

Phase Analysis: Process-> Phase Analysis

Phase analysis creates useful plots of data from microprobe files. However, this 
software is not compatible with most IBM or Macintosh graphics programs and the 
results can be printed only as a screen dump via the Seiko color printer.

Click on Sample and choose your group and sample name in the usual way, then 
choose Operation. In the Operation menu, choose Analysis to indicate the type of data 
to be processed (quant, map, etc.), the type of output desired (weight %, atom or 
intensity) and whether or not to apply the least-squares fit line. An intensity display 
using quantitative data displays net intensities. If map or line data is displayed, the raw 
intensity is used.

Choose Element, to select a plot type (histogram, ternary plot, 2-dimensional scatter 
plot (x-y)) and assign appropriate axes and display levels. Color allows you to choose 
the marker symbol, color and size for the plot. Save Result gives you and opportunity 
to save the plot file. Plot actually initiates the plotting, either as an overlay to a plot 
already displayed, or as a new plot. Because conditions for phase analysis don't default 
to the previous analysis conditions, you must choose the elements again for eaeh plot 
you create.
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Summarizing Data: Process -> Quantitative -> Summary

Choose your group by clicking on Group, highlighting your choice in the resulting list, 
then clicking on OK. Choose the samples you want to include in the summary by 
highlighting them in the list. Click on OK. Then select which analysis points you wish 
to summarize by clicking on the appropriate buttons or selecting them in groups using 
the Some or All buttons. Choose the type of summary you wish to create.

Normal: output as produced on screen during measurement

Calc: choose ratios, sums from a list which appears

Atom: cations based on # of cations chosen in printout condition

100%: analyses normalized to 100%.

Wt %: weight %

Net: net counts

Current: beam current

Total: totals only, weight %

L-Value: peak positions

K-ratio: uncorrected weight % analyses

Stage: total weight %, stage position, date and time, comment

Standard: standard data

Spreadsheet: weight % summary suitable for export to spreadsheet

Depending on the type of summary you have chosen, options may be available which 
affect the appearance of the output (e.g. choosing to use row or column format).

When you have chosen your summary options, click on Type Out and the summary 
will be displayed in a new window on the screen. To print a copy of your 
summary, choose Print in the data display window.

To save the summary for transfer to a floppy or to another computer over ethernet, 
choose Save in the display window. Another small window will open to allow 
you to choose a path and file name, though a default is provided. Please use the 
default path name to prevent the proliferation of summary files on the disk.

In the display window, choose Clear to clear the current data. If you just Close, other 
summaries you create before exiting the Process Menu will be appended to the 
data already on display, so if you then choose to do a Save you will be saving 
multiple summaries in a single file.
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Off-line Data Correction:

Menu: Process -> Quantitative -> Off-line Correction

This will open a window similar to the window for Analysis -> Quantitative.

Within this window, choosing Sample will give you the opportunity to choose a group 
name and the sample of interest.

Conditions will offer a series of choices similar to those under Analysis -> Quantitative 
-> Measurement.

Standard Data will open a window allowing you to edit your standard data... this 
window is very slow to come up, so be patient.

K-Ratio Input & Correction will open a window which allows you to manually 
adjust K-ratios and re-correct your data.

Intensity Input & Correction (for WDS analyses only) will open a window where you 
can manually adjust net intensities and beam currents and re-correct your data.

File-Read & Correction (for WDS analyses only) will open a window where you enter 
the old file name under Read, the new file name under Save, and choose the 
samples you wish to correct. If you do not rename the new file the original data 

overwritten.

Read Intensity and Apply will perform and print the correction. 

Recommended Use and Warnings about Off-line Corrections:

The most common use of off-line correction is to check the quality of various possible 
standards available. There is generally no problem with substituting standards and 
recalculating your analysis as long as the new standard was analyzed under the same 
conditions as the unknown (check PHA settings, peak and background positions and 
EOS conditions to make certain they are identical between standard and unknown). 
Note that if a re-calibration of a standard has been done between the original analysis 
and the off-line correction, the most recent standard data will be used in the correction 
procedure. Off-line correction may also be used to recalculate analyses using different 
oxidation states (e.g. Fe2O3 and FeO) without any problems.

Other uses of Off- Line Correction software are up to the users' discretion, but manually 
changing counts of k-ratios of either standards or unknowns will tend to be subjective 
and will generally degrade the scientific integrity of the analyses. Adjusted data should 
not be published as truly quantitative results unless thorough explanation of one's 
methods and reasoning for such corrections are also presented. It is essential that users 
understand what they are doing when using the Off-line Correction software. If there is 
any question of the quality of either the standard or unknown data, it is generally 
considered better to repeat the analyses rather than correct them off-line.

To insure that the original analysis files will not be overwritten by the off-line 
correction, enter another file name in which to save the new data. The user should also 
make note of the original conditions and what is being changed.
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Transferring data to a floppy or over ethernet (for IBM/PC users):

After creating summary files, you may transfer files over ethernet by following the 
transfer instructions below (omitting references to floppies).

i
To transfer the files to a floppy, turn on the PC and load your floppy in disk drive A or 
B. The floppy must be IBM formatted, and therefore must be converted later to 
Macintosh format to be read by Apple computers.

At the DOS prompt, change to the appropriate floppy drive by typing A: or B:. Then 
type

ftp workstation
where workstation = name or IP address of the workstation. Check with lab
personnel.

In Menlo Park, you may open the connection by simply typing "f" at the first prompt, 
thus avoiding typing in the IP address.

You should receive a message saying you are connected to the workstation and asking 
for a login. Log in the same way you would log onto the HP workstation when running 
the microprobe.

If you want your spreadsheet file transferred so that it can be opened in Excel, you must
type

binary 
at the next prompt.

To transfer the files to the floppy, type

get pathname!filname new file 
If you omit "new file", the file will be copied as "file name".

Be aware that although UNIX allows long file names and extensions, the resulting DOS 
names will be truncated to eight characters and extensions to three.

The "get" command doesn't recognize the * convention for file naming. If you have a 
number of files to transfer and need to use the * convention, the command is "mget" 
instead of "get".

When the transfer is complete, remove your summary file from the probe workstation 
by typing

rm pathname/filename

Type "quit" to exit from the file transfer program and return to the DOS prompt. 

You can check the contents of your floppy by typing

dir a: (or b: if that is where your floppy is) 
on the PC.

View your transferred data on the PC a screen-full at a time by typing 

type filename I more
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Transferring Data Files to Your Mac Using Fetch

Fetch is free-ware. It) is a Macintosh-style version of FTP (file transfer protocol), which 
allows a user to log onto another computer remotely and copy files to their own system 
through a network. Therefore, in order to do this you must have a copy of Fetch loaded onto 
your Mac, you must be on the network, and the network must be functioning. You cannot 
create files using Fetch. Summary files must be created on the workstation.

1. Open Fetch. If the HP Workstation you wish to contact is already nicknamed in your 
shortcuts menu, go to step 2. If you have not already loaded the appropriate 
workstation information in the Shortcuts directory, click on Fetch in the command bar 
at the top of the screen and choose Edit Shortcuts from the pull-down menu. Enter in 
the following information highlighted in bold below into the Edit Shortcuts window:

 Shortcut (this is the official "nickname" of the HP workstation):^^ lab personnel for 
info.

 Host (this is the IP address of the workstation computer): see lab personnel for info.

 User ID (this is the sub-directory that holds all user files): see lab personnel for info.

 Password: see your lab personnel for info.

 Click on OK or hit the return key.

2. In the main window, click on the arrow next to the word Shortcuts, and choose the 
nickname of the HP Workstation from the pull down menu.

3. Choose the Binary option if you are transferring a spreadsheet file.

4. From the Fetch window, click on "open connection". A new window will open.

5. If the workstation information is not already loaded in the new window, click on the 
arrowhead pull-down menu next to the word "Shortcuts" and choose the HP 
Workstation name from the Shortcuts list of aliases, or load in the required information 
manually. Click on OK or hit return.

6. When the little dog stops running, find the file you want to transfer in the directory on the 
left side of the Fetch window. Highlight the file you want to transfer and click on "get 
file". A new window will open.

7. At the bottom of the new window there will be two boxes filled with question marks, 
indicating that the file is unformatted. You will need to change them to indicate 
spreadsheet formatting. To format the transferred file as an Excel file, click on the 
arrow button in the lower right corner and choose Microsoft Excel. Choose the 
directory on your machine to which you want the file transferred. Click on OK or hit 
return. You should now find the file you transferred in the appropriate directory and be 
able to open it directly by double clicking on its icon, or by opening it through Excell.
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Backing Up Data

It is very important that at the end of each probe session you back up the data you have 
just collected. Each person has been given a portion of a magneto-optical (MO) disk 
for this purpose, and is responsible for his or her own data. Load your MO disk into the 
MO drive with your label facing up.

Menu: Utility-> File Utility

Choose Media Access from the resulting display, and then Backup from the options 
which are presented. A new window will open. Choose MO Disk as the media type, 
and make choices about what you wish to back up. Because of the time involved, you 
will probably only want to back up your measurement conditions and your new data 
each time. Standard data is in common use and will be backed up on a regular basis as 
part of the lab management schedule.

To restore data that has been backed up on MO disk, choose Restore under Media 
Access. A new window will open in which you choose MO Disk as the Media type. A 
window will inform you that current data will be destroyed. It is advisable to transfer 
your data sample by sample to avoid re-configuring your directory and wiping out data 
that has not been backed up. Data files with the same names will be overwritten. Be 
patient-this is a very slow process. It is possible to access other functions of the 
microprobe (set up and analysis, etc.) while the MO Disk is being searched.

Using the Data General Workstation to access Microprobe Software:

It is possible to access microprobe software via the Data General workstation. However
you **MUST** limit your activities to items which will not affect the operation of 
the microprobe, such as creating summary files, operating Phase Analysis software, 
etc. If you have any questions or concerns about possibly interfering with the HP or 
microprobe functions, consult with lab personnel before proceeding.

To access the HP workstation, log on to the DG, then at the prompt, type

xhost HP workstation name

telnet HPworkstation name 

Log on as you usually would on the microprobe.

setenv DISPLAY DG workstation name :0 
off_menu

At this point you will be in the EPMA menu on the microprobe. Again, do not interfere with 
microprobe analyses by removing or moving files, running Off-Line corrections or trying to 
set up or run analyses from the DG.

To exit:
Initializer End Menu

This will exit the EPMA menu on this terminal (the DG) only. At the prompt, type "logout" 
or "lo", and you will be returned to the DG workstation environment.
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SECTION 16: Tips and Troubleshooting

Alarms:

There are four alarms you may encounter while running the microprobe: a stage limit alarm 
(loud fast beeps which occur after a stage movement); a vacuum alarm, which is rather faint 
and sounds like it is coming from behind the instrument (you should have heard valves 
closing before this); EDS loss of communication alarm (two alternating tones which are 
rather loud); and a faint alarm signaling that the liquid nitrogen in the EDS liquid nitrogen 
tank (EDS Dewar in Figure 3.1) is low. Follow the instructions below if you hear an alarm.

Stage Limit:

press the REQ button and move away from the stage limit with the joystick. If the 
joystick is disabled, open the Stage Monitor window and move the stage position 
(by clicking on the appropriate buttons). Notify laboratory personnel immediately 
whenever this happens.

Vacuum loss or decay:

First check the vacuum gauge to confirm that the vacuum has degraded (greater 
than approximately 1 x 10"5 torr and rising). If you cannot tell whether or not the 
vacuum is degrading, or if the vacuum looks fine, consult lab personnel. Once you 
confirm that the vacuum has degraded, turn the High Voltage off by pushing the 
HV button on the console. Check to see that the green button to the right of the 
airlock is lit (see lab layout Figure 3.1). If the button is dark, push it once. It 
should light up and the airlock should vent. Then call for help from a lab attendant. 
A loss of vacuum may destroy the filament (which will cost you several hours of 
down probe time), and it may also damage delicate and costly parts within the 
column.

EDS communication loss:

See instructions below about EDS loss of communication. 

Liquid Nitrogen tank low:

See Figure 3.1 for location on the instrument. Do not use the EDS until this is 
refilled. Notify the appropriate personnel immediately.

Default Analysis Conditions:

Sometimes a user will set up an analysis and discover that the analysis was performed 
using conditions other than those they thought they chose, causing frustration and loss 
of time. To prevent this unfortunate occurrence, it is essential for users to understand 
the nature of system defaults on the microprobe in order to be confident that the 
analysis conditions which they intended are the conditions which will actually be used.

Difficulties stem from the fact that the defaults are, in most instances, dynamic, i.e. they 
are determined by "last use" rather than returning to values set by the controlling 
software. Therefore, while on one occasion the defaults that you find may be precisely 
what you want, you cannot depend on the same defaults being in effect the next time 
you set up an analysis. Default conditions do not automatically accompany the sample; 
that is, the defaults are based on the last use of the analysis package in question (Quant,
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Map, etc.), not the last use of the analysis package for this sample. If a user sets up 
Sample 1 with a set of conditions Cond 1, then sets up Sample 2 with conditions Cond 
2, then returns to Sample 1 to measure it, unless the user resets the conditions to Cond 1 
values, the conditions in Cond 2 will be used for the measurement of Sample 1.

The user can gain control of the defaults by taking advantage of the Condition Load and 
Condition Store features in the different analysis packages. When all the conditions for 
analyzing a certain sample have been defined, the user should use Condition Store to 
store those conditions to a file. Then that set of conditions can be recalled using 
Condition Load at any time to become the current defaults for that type of analysis. 
Storing standard conditions thus simplifies returning to your previously used conditions 
through Condition Load, though the data in the standardization file will be from "last 
use".

If the probe software is configured so that each user has his or her own directory, the 
dynamic defaults will be set by that user's own "last use". If any of the analyses are 
snared across the system (e.g., standard data is shared by creating a link to a common 
standard file structure) then the "last use" defaults will be those conditions set by the 
last user of that type of analysis. Defaults for standard analyses are determined by the 
last use for the standard in question, not the last use of standard analysis in general. 
Storing standard conditions thus simplifies returning to your previously used conditions 
through Condition Load.

Common Errors 

Impatient user:

If the workstation software fails to execute a command instantaneously, some users 
become impatient and click on the same command button or buttons several times. 
This can cause the system to crash because the redundant commands go into a 
buffer and the system tries to execute the same process over and over. The remedy 
is simple: click the mouse button once and be patient.

Some software operations may take several seconds before you see results, and 
often there is no indication on the screen that anything is happening. One common 
result of over-clicking is overloading the print buffer jobs will be printed as many 
times as you click PRINT. To clear the print buffer, see the instructions below.

Caps-Lock key:

When the caps lock key is depressed, the EPMA menu is effectively disabled, since 
an upper-case mouse click does not have the same effect as a lower-case mouse 
click. If the menus will not open, the caps-lock key is the first thing you should 
check.

Airlock: (automatic in Reston)

After loading a sample into the analysis chamber and closing the gate valve, it is 
easy to forget to vent the air lock. The green button next to the gate valve handle is 
lit when the air lock is vented and dark when the air lock is evacuated. If the air 
lock is not vented by pressing the green button, the roughing pump will continue to 
pump on the air lock rather than backing the diffusion pumps, causing the vacuum 
to degrade. The accuracy of your analyses will be severely affected; you may lose 
the filament and if the vacuum becomes too badly degraded, the entire system will 
shut down. Always vent the airlock after changing samples.
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Useful Operational Information 

Updating window displays:

Not all window displays are updated automatically when the information on display 
is changed. Before becoming concerned that a change that you have made wasn't 
entered into the system, back out of the window sequence where you are currently 
operating. Close the windows, perhaps as far back as to the main EPMA menu, 
then re-open the windows and see if the expected change has occurred.

Setting spectrometers to default conditions:

Occasionally the spectrometer conditions are changed to other than the default 
values. To assure that the peak position, gain, etc. are set to the hardware default 
values for this crystal on this spectrometer, you may choose Channel and Crystal 
in the WDS Conditions window (Measurement -> Element Conditions -> WDS 
Conditions) in each of the analyses packages (Standard, Quant, Line, Map) even 
though you don't want to change them.

Clearing the print buffer:

  Turn off the printer (switch on back right side of the printer).

  Open an HP terminal window by clicking on the gray screen background, then 
dragging to NEW WINDOW and clicking, or by opening an existing HP Term 
icon.

  Type Ipstat to show the active printer jobs. Lpl is the system name for the dot 
matrix printer in Menlo Park and Denver. The line printer is called Ipl32 in 
Reston.

  The command cancel I pi -a clears all jobs in the print queue for the printer named 
Ipl. To cancel a specific job, substitute the job number (use Ipstat to determine 
the number) for the "a" in the previous command (e.g., cancel Ipl -1874).

  When you turn the printer back on it should print "canceled" and then quit.

  To re-create print jobs that you deleted from the print queue, you must repeat the 
procedure you used to create them the first time. There is no way to retrieve jobs 
deleted from the print buffer.

Freeing a frozen joystick:

Users should understand that the joystick works most effectively when it is treated as a 
sensitive piece of high precision equipment. Do not treat the joystick controls roughly 
or use sudden movements and then expect the stage to respond immediately.

Occasionally the joystick on the console locks for no apparent reason. It can 
sometimes be freed by pressing the TEST key.

If the TEST key doesn't free the joystick, try pressing the STORE and REQ keys 
on the joystick console. Be aware that by doing this you may be storing a position

70



you really don't want, so you would be wise to confirm your positions after doing 
this.

If the above methods fail to free the joystick, try opening the Stage Monitor 
window from the main menu (Monitor -> Stage) and clicking on the directional 
arrows or Test, or clicking Read and then Move in the Pos. Input window.

Initialize -> Reset Analysis will sometimes free the joystick.

As a last resort, do an End of Menu. This procedure is described in the section of 
this chapter about regaining control if the system hangs up. Close any open 
windows before doing this.

Regaining control if processing hangs up: (arranged in order of increasing desperation)

Reset Analysis: (Initialize -> Reset Analysis)

This resets the windows for whatever analysis routine is open. Reset Analysis is 
quick and relatively harmless, but it is wise to check for lost information after using 
it.

End of Menu: (Initialize -> End of Menu)

Close any open windows (if possible) before doing this, as information in open 
windows may be lost, and temporary files created by the system will be deleted.

Choosing this command will shut down the EPMA software. A window asking you 
to confirm that you wish to end the menu will appear, click on OK. The screen will 
clear and the EPMA icon will disappear from the screen.

Wait for all disk activity to cease (a few minutes), then click in the gray background 
field and drag and click to select "EPMA MENU" from the blue menu box. As 
EPMA is reloading, the background screen will gradually become a lighter gray, 
and eventually the EPMA main menu will reappear. Be patient. This will also take 
a few minutes.

Even after the EPMA menu is functional again, the system will be slow for about 20 
minutes as the hard drive goes through what JEOL calls "garbage collection", 
searching the entire hard drive for files which must be deleted. The restart process 
can be monitored from the EPMA window whose icon is at the bottom right of the 
workstation screen.

System Shutdown: (Initialize -> System Shutdown) 
(Notify lab personnel before doing this)

This will shut down processing in an orderly way, and will destroy all temporary 
files created by the program. Close any open windows (if possible) before doing 
this, as information in open windows may be lost.

  A window asking you to confirm that you wish to shutdown will appear, click 
on OK. The screen will clear, and the message "halted..." will appear when 
shutdown is complete.
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  Turn off the computer, using the rectangular ON/OFF button on the computer. 
Wait at least 15 seconds, then push this button again to restart the computer.

The computer will reboot automatically, and you will be prompted for a login name 
and a password. The EPMA software will automatically be restarted, so be patient 
at this point; the screen will gradually become light gray and eventually the EPMA 
menu will appear, and the system will become functional again, although it may 
remain sluggish for 15-20 minutes while it continues its "garbage collection".

Soft reboot: Press the SHIFT-CONTROL-RESET keys simultaneously. 
(Notify lab personnel before doing this)

A soft reboot will dump everything and put you back at a login command. This is a 
very messy way to end things, so only resort to this if mouse control is totally 
locked up and none of the above options can be used.

After login, you will have to start the EPMA menu manually by clicking on the 
background to get the root menu, then dragging and clicking to choose EPMA 
MENU. Be patient as the screen gradually becomes lighter gray and eventually the 
menu appears.

Hard reboot: ON/OFF switch (white button on the HP workstation computer. See
Fig. 3.1): 

(Notify lab personnel before doing this)

This is truly a desperation move. If you have not been able to do an End of Menu 
or System Shutdown, rebooting will take 15-20 minutes before the login prompt 
appears, as the system must do a major clean-up. The procedure for restarting is the 
same as described under System Shutdown.

Re-establishing software-to-hardware communication:

If the EDS alarm is sounding (it is two alternating tones, like a European police 
car), if the EDS system is not working, or if the Present Values or EPMA window 
lacks information on one or more spectrometer, or for some other reason you 
believe that communication is broken between the workstation and the instrument, 
first notify a lab attendant.

Do an End of Menu operation as described above. But before restarting the EPMA 
menus press the appropriate restart button or buttons as described below.

EDS reset button:
This is located on the back of the EDS control unit, below the desk level and behind 
the main console. Buried beneath wires coming out of the unit is a button clearly 
marked RESET. Push this button once and a series of tones will be heard which 
sound like a major scale or a vocal exercise, indicating that communication has 
been re-established. Restart the EPMA windows and continue normal operation.

WDS reset buttons:
These are located on the back left side of the visual consoles, next to the instrument 
They have rounded caps and stick out of the console about an inch. To re-establish 
communication between the workstation and the instrument, push both buttons



simultaneously. Restart the EPMA menus and check the Present Values and EPMA 
windows to make sure that communication has been re-established. If the channel 
and crystal information are still incomplete in the Present Values window after this 
operation, notify a lab attendant.

Visual console reset button:
This is a recessed orange button located near the front of the visual console oik the 
right side of the unit next to the workstation monitor. Pushing this button once 
resets the console screens to SEI images and resets the focus of the images. It is not 
necessary to do an End of Menu before resetting the console screens.

Dealing with a power outage:

  Turn off the system by turning the key located to the left of the HP workstation 
monitor to the OFF position.

  Press HV button, to turn off the high voltage switch. The button should be 
raised, not depressed.

  Turn off the HP workstation computer by pushing the white rectangular button 
on the computer (see Fig. 3.1) and turn off the workstation monitor.

  Turn off other computer, monitors and printers. 

Restarting after a power outage:

  Wait several minutes after power is restored to avoid subjecting the equipment 
to large power surges and fluctuations which often occur at such times.

  Turn on the room lights and see that they are fully bright. If they are not and 
any dimmers are turned all the way up, don't turn on the probe.

  Turn the key on the console to START. It should automatically spring back to 
ON and stay there.

  Check the vacuum monitor, and turn it on if necessary (ON/OFF switch is on 
the back). When the vacuum is stable within the acceptable range, you should 
be able to run. The acceleration voltage must remain off until the vacuum has 
recovered.

  While waiting for the vacuum to recover, turn on the workstation computer, 
monitor, and any other auxiliary items. The computer will probably take a total 
15-20 minutes to reboot, so be patient. You will eventually be prompted to log 
in and give a password, after which the EPMA software will be loaded 
automatically.

  Choose Monitor -> Present Positions, and leave this window open. Choose 
Monitor -> EOS Conditions, and make sure the PCD (Faraday cup) is blocking 
the beam. If the vacuum is in the proper range and the workstation is 
communicating with the instrument, turn on ACCEL VOLTAGE on the main 
console. The Present Values window should display the beam current If the 
current is reasonable (about 20 nanoamps) and stable, you should be able to run, 
and can continue with the normal start-up procedure. If the current is 
abnormally high, low or non-existent, notify a lab attendant. The filament may 
have blown, or the beam may need to be realigned.
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Useful Analytical Information

Poor totals during Quantitative Analysis (mechanical causes):

For samples with no H, HO, H2O, Li or other elements or species not analyzed, totals 
should be between 98.5 and 101.0 weight %. There are many possible causes for poor 
totals, including poor standardization. Some possible causes and solutions are 
described below.

You may be on the wrong sample or standard. Consult images of the standards or 
unknowns, or use EDS to determine the elements present.

The beam may be rastering. If you see an image on the console screens while you are 
analyzing your sample or your standard, open the EOS conditions window and 
change the probe scan setting to OFF for the analysis or standardization. 
Rastering during standardization can give very high totals on the unknowns. 
Rastering during quantitative analysis will generally give low or high totals 
(depending on what the beam is scanning).

The vacuum may be degraded. Make sure the green button next to the gate valve 
handle on the airlock is lit. If it is dark, push the button once to vent the airlock. 
The vacuum in the sample chamber should slowly recover (see the section above 
entitled "Venting the Sample Chamber Airlock" for more information).

You may have missed an element. Acquire an EDS spectrum on the sample to see if 
you missed any major or minor elements.

The beam may be mis-aligned. Ask a lab attendant for assistance if you think this 
might be the source of your problem.

The carbon coat may be too thick or too thin on either the standard or the unknown, 
the standard may be damaged, or the sample may not be properly grounded tot he 
holder. Consult a lab attendant if you suspect carbon coat problems or damage to 
the standards.

You may be using the wrong standard. There are preferred standards for each 
element depending on the type of phase being analyzed. If you analyze a glass 
with an olivine standard, you may find the totals to be low because the peaks have 
different shapes or slightly different peak positions. Ask a lab attendant which 
standards are preferred for the phase(s) you are analyzing.

Loss of alkali metals, F and Cl may bring totals below 100%. Always analyze for 
sodium and/or potassium first. In general, do not use a peak search for analyses 
of alkali metals. Also, use a defocused beam, short counting times and low beam 
currents whenever possible. High silica glasses are notorious for Na and K loss. 
If significant loss is still occurring even under these conditions, consider cutting 
down analysis times and/or sample current, or increasing the beam diameter. 
Alkali loss can be monitored using Monitor -> Chart Recorder. The chart 
recorder should be used to determine analysis times for alkalis. Roaming around 
on the sample with the joystick during the analysis may be a last resort if the loss 
of alkalis during analysis is so rapid that shortening counting times and lowering 
the beam current will degrade the counting statistics appreciably.

74



Loss of volatiles may bring totals below 100%, but nothing can be done because it is 
not possible to analyze quantitatively for water with an electron microprobe. The 
instrument is capable of analyzing for carbon and oxygen. Consult with 
laboratory personnel if you are interested in analyzing for these elements. If you 
wish to analyze for volatiles, try using SIMS or IR spectroscopy. Otherwise, 
using standard microprobe techniques and not analyzing for oxygen or carbon 
directly, expect totals lower than 100% for hydrous phases and glasses when 
using the microprobe. Consult Deer, Howie and Zussman (3) or another 
appropriate reference for expected cation ad weight % totals for the mineral or 
phase of interest.

Different oxidation states of elements (e.g. Fe+3 and Fe+2) in your standard or
unknown (other than those set-up in analysis conditions) could cause low or high 
totals.

Inclusions or holes may be present below the surface, leading to high or low totals. 

Low totals from Quantitative Analysis (software-related causes):

Stoichiometry may not be correct. Check that the data is being calculated correctly 
for all elements (e.g. SiO2 not Si2O3).

The default peak position for an element may not have been updated to the current 
best position, so data was not collected at the optimum peak position. This is 
most likely to be a problem only for minor elements when not enough counts are 
generated to have a peak search performed at the time of analysis, or if the peak 
search has specifically been turned off. To check this, choose Element Conditions 
in the Measurement menu of the appropriate analysis type and compare the peak 
positions there with the peak position in the window "behind" it which contains 
all the possible configuration choices for the element in question. Peak positions 
are automatically updated in the window containing the configuration choices, but 
not in Element Condition files.

Not all of the analytical information may have been reported. If all elements being 
analyzed are not included in the correction, check the element order in the printout 
conditions window. Include any missing elements by clicking on the appropriate 
element names. The element order shown at the bottom of the window is the 
order in which the analytical results will be reported. Remember, this is 
independent of the order in which they will be analyzed.

Analysis conditions may not be the same as the standardization conditions. Check the 
voltage settings: PHA gain, high voltage (HV), baseline (Base L.), voltage, 
window, and differential (D) versus integral(I) settings~in the standard analysis 
and quantitative analysis condition columns that you are using. Note that if the 
integral mode is chosen, the window setting is ignored. If your analytical 
condition columns for standard and unknown do not have the same settings, 
consult a lab attendant. Please do not change PHA settings or voltage settings 
without consulting a lab attendant first.

The beam current for your analysis may differ from the beam current for your 
standardization. (Check the EOS conditions window or the printout). If the 
standardization was done at a significantly different beam current than the 
analysis for one or more elements, you may have to re-standardize. Raw data are 
stored as counts/sec/nanoamp, so beam current differences should only lead to 
problems if the counts are low and the difference in beam current is great.
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Spectrometer choice:

Even though there is approximately 1% reproducibility on flipping the crystal, it 
is best to avoid flipping crystals during quantitative analysis whenever possible. 
If you do flip crystals, be sure to do a peak seek after flipping.

Spectrometer 2 has a smaller Roland circle radius and uses larger crystals, thus it 
gives a higher count-rate for better sensitivity to minor elements. The lower limit 
for crystal positioning is higher than the other spectrometers, which means that 
some elements accessible on LIF or PET on other spectrometers will not be 
accessible on spectrometer 2. Also the peak to background ratios are not as good 
as other spectrometers. Therefore, your best sensitivity may be on another 
spectrometer. When choosing a spectrometer and crystal, first choice is to use
the Ka line. If more than one crystal possibility exists, it is sometimes better to 
choose the one with the lower peak position. Doing this will give a higher count 
rate but poorer resolution. It may in fact be better sometimes to use the higher 
position to resolve interferences such as S-Pb, V-Ti, S-Mo, etc.

Peak search:

If the x-ray intensity for a minor or trace element is too low for a peak search to 
be successful, the last measured position for that element is used. (See, however, 
the notes about default analysis conditions and software-related causes of poor 
totals earlier in this section.) Peak search thresholds are:

15 kV 100 cps

20 kV 200 cps

25 kV 300 cps

When setting up measurement conditions for an unknown, a normal peak seek 
choice would be 1. Peak seek = 0 means no peak search is ever done. For 
standards, the peak seek parameter is automatically set to 2 unless it is set to 0, 
meaning two iterations are done on the peak search over successively narrower 
regions even if the peak seek number set in Analysis->Standard->Measurement- 
>Element Conditions is 1.

In Analysis -> Quantitative -> Measurement -> Additional Functions, it is 
possible to choose to skip peak searches during analysis or only to do them once 
every n points, so there is seldom a reason to set the peak seek parameter to a 
value other than 1.

EOS conditions:

Possible kV range is 0-40, but 15-20 is usually suitable for most geological
applications. Check with lab personnel before running the instrument at a higher 
voltage.

Normal probe current (PCD in) range is 10-50 nanoamps (1-5 x 10"8); usually 10-25 
nanoamps is appropriate for silicates. If possible, use a higher current for 
mapping.
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Appendix A: Some Useful UNIX Commands

Please do not use UNIX commands before consulting lab personnel. 

Create a UNIX window:

Move the pointer to anywhere on the gray background. Push and hold the mouse button, 
and drag the pointer down the menu that appears until the option "New Window" is 
selected. Release the mouse button. An outline of the window will appear, with a small 
box open which gives the current coordinates on the screen. Move the outline with the 
mouse to a convenient position for the window you are opening and click once to create 
the window.

Destroy a UNIX window:

Type "exit" or CTRL-D in the window.

Alternative method:
Use the window menu option "Close" accessed by clicking on the upper left comer of 
the window.

File Structure of Software for JEOL 8900 Superprobe

Data Structure   JEOL8900
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UNIX is case sensitive!!

UNIX Command

cancel job # 
cd dir-path 
cpfilelfile2

exit

find dir -name file -print

head -nfile

id

lp file

Is -aF

more file 
mkdir dir
mvfilel file2

pwd

rmfile 
rmdir dir

tail -nfile 

who am i

Definition

cancel a print job
change directory; default to home directory
copy file 1 tofile2

exit the current process, quit a window

find file, starting search at dir

list first n lines in file

list one's user id and group

pnntfile

list contents of current directory

list file one screen-full at a time 
create a new directory 
move or rename filel tofile2

print current working directory

delete (remove) file 
delete an empty directory

list last n lines of file 

show own user id
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Appendix B: Quick Reference Summaries 

SECTION 4: Start-Up (Reston)

1) Turn the SONY and HP monitors on. !

2) Check vacuum monitor for stability and acceptable vacuum reading.

3) Reset filament, check saturation level and beam focus (spot size).

4) Choose Initialize -> Change Directory to set your personal directory

5) Proceed with sample exchange, standard analysis, etc.

SECTION 4: Shut-Down (Reston)
Normal shut-down

1) Put the beam on brass or somewhere off the samples, transmitted light lens retracted.

2) Select full picture mode and SEI image.

3) Set magnification to 300,OOOX and scan speed to SLOW (S3).

4) Block the beam (PCD button lit) and turn OMTV and PRBSCN off.

5) Lower the filament saturation by ten clicks (Filament window in EOS Monitor). Leave 
these windows open.

6) Close any other open windows, leaving the EPMA menu, Present Values window and the 
EPMA and CONSOL icons.

7) Turn the SONY and HP monitors off,

8) Make sure a log book entry is completed, noting problems, solutions and a summary of 
your analysis conditions. Leave the lab area tidy.
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SECTION 4: Start-Up (Denver. Men In)

1) Turn the SONY and HP monitors on.

2) Check vacuuni monitor for stability and acceptable vacuum reading.

3) Turn other peripherals on (color printers, PC, standard printer, optical drive)

4) Turn up the contrast and brightness located under CRT screens .

5) Turn the accelerating voltage on if it is not already on.

6) Set console screens to SEI image, FAST scan speed, PRBSCN on, magnification 40X.

7) Take the Faraday cup (PCD) out.

8) Turn on OMTV and focus light optical image.

9) Choose Initialize -> Change Directory to set your personal directory.

10) Proceed with sample exchange, standard analysis, etc.
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SECTION 4: Shut-Down (Denver. Menlo)
Normal shut-down

1) Put the beam on brass or somewhere off the samples and retract the transmitted light arm.

2) Select full picture mode and SEI image.

3) Set the magnification to 300,OOOX and scan speed to SLOW (S3).

4) Put Faraday cup in (PCD button lit)

5) Turn OMTV and PRBSCN off.

6) Turn high voltage off (ACC VOLTAGE button not lit).

7) Close open windows, leaving only the EPMA menu and the EPMA and CONSOL icons 
on the screen.

8) Turn the SONY and HP monitors off,

9) Turn the DG monitor off. Turn the brightness and contrast knobs on the CRTs all the way 
down. Turn both color printers off.

10) Make sure that the GREEN BUTTON IS LIT !!! If it is not lit, press it to vent the 
sample exchange airlock to atmosphere.

11) Write an entry in the log book, noting type(s) of analyses, problems and solutions, and 
remove your belongings from the area. Turn off the lights, and (M) close the blinds 
before you leave.

12) Turn off the PC.
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SECTION 5: Sample Exchange

1) Remove the transmitted light arm from the chamber! (LENS button light off). 
Severe damage will occur if this is not done before inserting samples.

2) Select Sample Change from the Stage Monitor menu, and click OK.

3) Blank the electron beam. (PCD button lit)

4) Seal the airlock lid and press the green button to evacuate the airlock.

5) When evacuation is complete (green light goes off wait 2-3 minutes), slowly open the 
isolation valve between the column and the airlock, keeping the vacuum in the 10'^ torr 
range.

6) Retrieve the sample holder using the sample exchange rod.

7) Close the isolation valve. In Reston, the airlock vents automatically. In Menlo and 
Denver, one must press the green button to vent the airlock.

8) Open the airlock by lifting and pulling on the lid, remove and replace samples.
Remember to wear gloves, and be sure you have oriented the sample holder 
properly!

9) Seal the airlock lid, and press the green button to evacuate the airlock.

10) When the airlock is evacuated (when the green light has gone out wait 2-3 minutes), 
slowly open the isolation valve, keeping vacuum in 10"5 torr range.

11) Replace the sample holder slowly, so as not to lose y-axis calibration.

12) Close the isolation valve. The airlock vents automatically in Reston; in Menlo and 
Denver, one must press the green button .

13) Click on the OK button in the Sample Exchange confirmation window.

14) Make sure the green button is lit before proceeding.
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SECTION 6: Imaging

1) Set the accelerating voltage and adjust probe current.

2) Turn the probe scan (PRBSCN) on, set the magnification to 40X and unblock the beam 
(PCD out).

3) Use the VIEW button to select the image type (SEI, COMP, TOPO). If you are using 
COMP, turn OMTV off for best results.

4) Set the contrast and brightness. For SEI the control knobs are on the main panel; COMP 
and TOPO knobs are below the CRT screens.

5) Set the desired scan speed with the FAST and SLOW buttons.

6) Set the scan and reduce modes to PIC and FULL for the best image.

7) Find the desired location.

8) Set probe diameter to zero and focus the image at a high magnification.

9) The INST button can be used to set the instrument to the SEI conditions if you are having 
trouble getting an image.
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SECTION 7: Polaroid Photography

1) Set the CRT contrast and brightness knobs to their maximums.

2) Set the brightness and contrast for the SEM image. The ACB button will automatically set 
these to the default if the slowest scan speed is on.

3) Load the film (lever in the L position), making sure film sheet is inserted with the proper 
side down, and pull the film sleeve back. Press the L or R PHOTO button. A slow 
scan occurs while the photograph is being taken.

4) Push the film sleeve back in, slide the lever to P, and pull out the film. Follow the 
developing instructions on the film.

SECTION 7: SONY Printer

1) Select MENU on the remote or the printer to set multiple photos, separators, and
comments. Choose S for optical image or VIDEO for SEM image. Or (M, D only) 
choose the image type by using the buttons on the lower front of the SONY monitor: 
A-source button for optical, B-source for SEI image.

2) For an SEM image, adjust the contrast and brightness on the SONY monitor using the 
knobs on the main control panel.

3) On the remote or the printer press MEMORY-IN to put the image in memory, then press 
PRINT to print the image.

SECTION 7: SEIKO Printer

1) Bring up the image to print on the HP monitor.

2) On the Seiko printer, select the number of copies and press START.

3) Colors can be reversed (meaning that the black background becomes white) using the 
arrow keys next to the start button.
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QUANTITATIVE ANALYSIS 
FLOWCHART

Menu: Analyst -> Quantitative -> Sample

i Do you have a group name? '^~~~~ 
 i 
YES

Click on -GROUP*, highlight name. '
I 

Continuation of previous sampe?

Clfck on -GROUP". "NEW. enter name. -QIC

J
Choose 'NEW. enter sample name.'OK'

YES

Hlghlght name h list. -OK"

Menu: Anaysts-> OuanttatVe -> Measurement 
Is an appro prate analysis package 

set up for thfc sample?

Condition Load to choose pre-set condttons

Check conditions to confirm they are 
correct, modify as necessary

Correction method
Element Cond tton -> Elements

to choose elements for ana lysis 
Element Cond t ton -> Condttons

to choose spectrometers, crystal.
channels, count time, etc 

Standard Condition to choose standards
to be used 

Prtit-out Condtton to choose number of
oxygens, brief or complete output format 

Add t to na 1 Functions to set frequency of
background measurements and peak seeks

Focus optical and electron images
EOS Condtton to read KV. beam current.

probe scan, probe diameter 
Measure a known-unknown

Do you need to measure standards?   YES

Condtton Store to save condttons

Menu : Ana lysis -> 
Quant tat Ve -> Measurement

Stage Condtton to 
toad points to be 
analyzed 

I 
Preset Measurement

to acquire data 
_____|________
END OF ANALYSIS

Menu: Analysts-> Standard -> Sample
Hlghlght standard name 

Menu: Analysis -> Standard -> Measurement

Have you measured this standard 
before and stored the condttons?

Condtton Load
I

Check condttons. 
modify as needed

Element Condtton -> Element 
to choose elements for ana lysis

Element Condtton -> Condttons 
to choose spectrometers, etc.

Focus electron and optical Images
EOS Condttbn to read KV. current, scan. etc.

Condtton Store to store condttons 
Stage Condttons to set potits on standard 

for an a lysis i

Another standard? 

1

Preset Measurement to acquire data
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SECTION K! Standard Analysis

1) Use the Sample Menu to select the standard sample you wish to analyze.

2) Go to thb Measurement Menu; if you have previously set measurement conditions for 
this standard, recall them using Condition Load.

Load conditions for Quantitative Analysis before standardizing and re 
store the conditions in order to update standard data.

3) Check the Standard type, metal or oxide, and make sure the calibration curve is OFF.

4) Under Element Condition choose Element and select the elements to be analyzed on 
WDS and/or EDS. Choose Condition to set-up the conditions for each element to be 
analyzed.

5) Set up the instrument for an analysis, make sure the probe scan is OFF, the beam diameter 
is correct, and the current is appropriate and choose Read in the EOS Conditions 
window.

6) If you wish to use EDS for the analysis, open EDS Condition. Set up the instrument for 
an analysis (lOkV, aperture=l, 1024 spectrum data points) and Read in the current 
conditions.

7) Under Stage Condition choose Position Input to enter or modify/confirm the 
accumulation points for analysis. Click on Confirm and then STORE the 
accumulation points from the joystick control pad, after using the TEST button to check 
the focus of each point. Edit the comment line, press Apply to store all the information 
for that standard, and click on Close to close Position Input.

8) Select One-by-One followed by Acquire to analyze a single standard sample.

9) Choose Condition Store to save or update these conditions for future use.

10) To analyze multiple standards automatically, close the Stage Condition window and 
return to step (1). Choose the next standard sample and continue through step (9) for 
every standard you wish to measure.

11) In Preset Measurement select all the standards to be analyzed by clicking on their 
buttons, and press Acquire to start the analysis.

12) If any of the standard data needs to be altered after the analyses, select Check Data from 
the Measurement Menu. The data for the standard listed in the Standard Analysis dialog 
box will be displayed. Note: this menu item takes time to load, so be patient Change 
the data as needed and click Save, then Close to exit the window.
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SECTION 9: Quantitative Analysis

1) Click on the Sample Button. Choose or create group and sample names for this analysis.

2) If you wish to use analysis conditions previously stored, load them from Condition Load 
in the Measurement menu. Check that the settings are correct, paying special attention 
that the peak positions for minor elements are up-to-date, and skip to setting the EOS 
Conditions (step 7).

3) Choose the desired Correction Method.

4) In Element Condition choose Element to select the elements to be analyzed on WDS 
and/or EDS and those to be calculated. Choose Condition to set-up the conditions for 
each element to be analyzed.

5) In Standard Conditions select the standards that you have planned for your quantitative 
analysis. Be sure that the standardization dates match your standardization if you just 
did one.

6) Check output format and number of oxygens for calculation in Print-Out Conditions. In 
Additional Functions, set the frequency of background measurements and peak- 
searches.

7) Focus the electron and optical images. Set up the instrument for an analysis: make sure 
the probe scan is OFF, the beam diameter is correct, and the current is appropriate. 
Choose Read in the EOS Conditions. .

8) In Stage Condition choose Position Input to enter new positions or to modify/confirm 
the accumulation points (generally, do not use accumulated data for Quantitative 
Analysis). Click on Confirm and then STORE the points on the joystick control pad. 
Be sure to use the TEST button to check the focus of each point. Edit the comment line 
and press Apply to store all the information for that point. Click on the down arrow in 
the upper right to move to the next line to enter another point location, and repeat until 
as many points as desired have been entered. Click on Close to close Position Input.

9) For an analysis of only the position which is currently highlighted in the list, choose One- 
By-One, then Acquire. To perform multiple analyses automatically, select all points to 
be analyzed (blue=ON). Close to exit this window and go to Preset Measurement.

10) If you are using analysis conditions which you expect to use again in the future, use 
Condition Store to save or update them.

11) In Preset Measurement press Acquire to start the analysis.
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SECTION 10: Line Analysis

1) Click on the Sample Button. Choose or create group and sample names for this analysis.

2) If you wish to use analysis conditions previously stored, load them from Condition Load 
in the Measurement menu. Check that the settings are correct and skip to setting the 
EOS Conditions (step 6).

3) If you are setting up to do a qualitative scan, go to Element Condition and choose
Element to select the elements to be analyzed on WDS and/or EDS and those to be 
calculated. Choose Condition to set-up the conditions for each element to be 
analyzed.

5) Focus the beam and light optical image. Set up the instrument for an analysis and choose 
Read in the EOS Conditions. Make sure the probe scan is OFF, the beam diameter is 
correct, and the current is appropriate.

6) In Stage Condition choose Position Input to enter a new line or to modify/confirm the
line for analysis. Click on Confirm and focus each end of the line. Edit the comment 
line and press Apply to store the information. If you want to do quantitative analysis 
at each point on a line you have defined, choose Convert-to-Point-Table to store 
your points in the quantitative analysis point table, then proceed as for Quantitative 
Analysis (Section 9). To define another line, click on the down arrow in the upper 
right to move to the next blank line in the Stage Condition window and repeat until 
all lines have been entered. Click on Close to exit Position Input. For a single 
analysis of the line currently highlighted, choose One-by-One, then Acquire. To 
perform multiple analyses automatically, select the desired lines, choose Close to exit 
the Stage Condition window, and go to Preset Measurement.

7) If you are using analysis conditions which you may want to use again in the future, use 
Condition Store to save or update the analysis conditions.

8) In Preset Measurement press Acquire to start the analysis.

9) Choose Analysis -> Line Real-Time from the EPMA menu to view the analysis on the 
screen as it is being done.
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SECTION 11: Map Analysis

1) Click on the Sample Button. Choose or create group and sample names for this analysis.

2) If you wish to use analysis conditions previously stored, load them from Condition Load 
in the Measurement menu. Check that the settings are correct and skip to setting the 
EOS Conditions (step 4).

3) In Element Condition choose Element to select the elements to be analyzed on WDS 
and/or EDS and those to be calculated. Choose Condition to set-up the conditions 
for each element to be analyzed.

4) Focus the beam and light optical image. Set up the instrument for an analysis and choose 
Read in the EOS Conditions. Make sure the probe scan is OFF, the beam diameter is 
correct, and the current is appropriate.

5) In Stage Condition choose Position Input to enter a new area or to modify/confirm the 
area for analysis. Click on Confirm and focus each corner of the area. Edit the 
comment line and press Apply to store all the information for that area. If you want 
to do quantitative analysis at each point in an area you have defined, choose Convert- 
to-Point-Table to store your points in the quantitative analysis point table. Be aware 
of the total number of points you have set before doing quantitative measurements of 
all of them, then proceed as for Quantitative Analysis (Section 9). Click on the down 
arrow in the upper right to move to the next line to enter another area, and repeat until 
as many areas as desired have been entered. Click on Close to close Position Input. 
For a single analysis of the area currently highlighted, choose One-By-One, then 
Acquire. To perform multiple map analyses automatically, select the maps desired, 
choose Close and go to Preset Measurement.

6) If you are using analysis conditions which you may wish to use again, choose Condition 
Store to save or update them.

7) In Preset Measurement press Acquire to start the analysis.

8) To obtain a calibration factor relating the map colors to composition, go to Analysis -> 
Standard -> Measurement -> Standard Type in the EPMA menu and choose 
Calibration Curve. Then go to Analysis -> Standard -> Measurement -> Check Data 
and choose Element to display a window listing A and B calibration values for all the 
elements analyzed on this standard.

9) Choose Analysis -> Line Real-Time from the EPMA menu to view the analysis on the 
screen as it occurs. To apply calibration factors relating map colors to composition 
instead of absolute counts, choose Operation -> Map Display -> Level Modify and 
enter appropriate A and B values.
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SECTION 12: Serial Auto Analysis

1) Set up the individual analyses you will be doing in the appropriate analysis window: 
Quant, Map, Line, etc.. Save a condition file for each using Condition Save in each 
process.

2) Choose File -> Open Serial Directory to name your analysis sequence.

3) Choose Input to create an analysis "schedule". Choose the analysis type and use
Group/Sample to name the desired analysis routine. Stage Condition may be used to 
modify stage positions or focus or to add new positions.

4) Condition Load must be used to load appropriate condition files.

5) Choose Check to review the analysis conditions. If they need to be modified, close 
Serial Auto Analysis and return to the proper analysis menu to make appropriate 
changes, then return to Serial Auto Analysis and re-load the conditions.

6) Though it is not recommended that you make adjustments in the Serial Auto Analysis 
window, it is possible to do so. Condition Change may be used to adjust or select 
standards or EOS or EDS conditions.

7) When conditions for this analysis are correct, choose Apply. Use the arrows in the upper 
right corner of the Input window to move to another analysis in the series, or close to 
exit this window.

8) Run a single analysis routine by choosing One-By-One, or choose Preset to select 
multiple analysis routines to run.
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SECTION 13: EDS "Quick" Qualitative Analysis

1) Turn off the OMTV light (the EDS detector is light sensitive).

2) Choose EDS -> EDS from the EPMA menu. Wait for EDS to load and place window, 
then wait for the windows to be drawn (approximately 30 seconds total time).

3) To clear an existing spectrum, click the small button with the empty square on it in the 
EDS command window. A small window will pop up asking if you want to delete the 
acquired spectrum. Click OK.

4) Turn PRBSCN off to go to spot mode, or if it must be on, make sure the magnification is 
high enough so that you are not scanning epoxy or some other material that you wish to 
avoid.

5) Click on Acq Spectrum. This is a toggle switch. If EDS is not turned off by clicking 
again once the identification is made, the system will acquire for a set amount of time. 
The set analysis time can be adjusted from the EDS command window under Preset. If 
an error message appears saying the bias or voltage is zero, click on Analyzer and click 
bias to OFF, then ON to reset, and try Acq Spectrum again.

6) Identify peaks using the Periodic Table function.

7) Iconizing the EDS window (rather than closing it) when you have identified the phase in 
question will save time if EDS is to be used repeatedly, because the window will not 
have to be re-drawn.
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INDEX

ACB button 9
ACCEL VOLTAGE button 12
Additional Functions 41
Airlock 18, 69
Alarms 68, 72
Alkali metals, loss of 74
Analysis chamber 19
Analysis conditions

(see also Voltage settings)
background measurements 37
EDS Qualitative Analysis 56, 57
EDS Quantitative Analysis 37
EOS conditions 76
Line Analysis 42-43
Map Analysis 47-48
oxidation states 75
peak position 75
peak search 37, 76
Quantitative Analysis 36-38
saving 69
Serial Analysis 53
Standard Analysis 29-31
stoichiometry 75
Valence function 38
volatiles, loss of 75 

Back-scattered electron image 23
Background measurements (see Analysis conditions or Quantitative Analysis) 37 
Baseline (Base L.) 75 
Brightness and contrast 9,13

(see also Imaging) 
B_UP mode 8, 12 
Calibration Curve 29 
Cameras 8 
Caps-Lock key 69 
Carbon coat, too thick/thin 74 
Check Data 33 
Condenser lens current 9 
Condition files, loading 28 
Condition Load 69

Quantitative Analysis 36
Standard Analysis 28 

Condition Store 69 
Console/control panel features 9-10 
Contrast and brightness (see Brightness or Imaging) 
CRT (electron image) screens 8 
Data

accessing via telnet from the DG 67
backing up to MO disk 67
correction, off-line (recommended use/warnings about) 64
plotting data using Phase Analysis 62
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restoring data from MO disk 67
standard data

checking, eliminating points 33 
Search function 28

summary files, options 62-65
transferring 

IBM users 65 
Macintosh users 66 

Data General
accessing microprobe software 67
description of 10 

Defaults
spectrometers 70
Standard Analysis/Quantitative Analysis 68-69 

Dot matrix printer 9 
EDS 55-57

Acq. Spectrum 55
analyzer, detection conditions 56
aperture 38
communication loss 68
display, editing 56
EDS Condition

Quantitative Analysis 37 
Standard Analysis 31

liquid nitrogen tank (cryostat/Dewar) 68
Periodic Table 55
Preset 55
preset analysis 56-57
ROI (region of interest) 55
saving spectra 56
window description 55 

Electron beam
aligning, centering (objective lens) 14-15
alignment problems 74
beam current, discrepancies in 75
blocking 18
Faraday cup (PCD) 9
focus and location 13
focusing (objective lens) 9
probe current (condenser lens) 9
rastering 9, 74
spot mode 9

EMP (emission pattern) 14 
End of Menu 71 
EOS conditions 76

EDS analysis 57
Line Analysis 43
Map Analysis 48
Quantitative Analysis 36
Standard Analysis 30 

EOS Monitor window 12 
EPMA menu 69 
Ethernet 65 
Faraday cup 9
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FAST button 8 
Filament

saturation 14 
window 12 

Files
loading

Quantitative Analysis 36 
Standard Analysis 28 

software (UNIX) file structure A-l 
storing

Quantitative Analysis 40 
Standard Analysis 33 

FINE button 9 
Fluorescent sample 13 
Focus

electron image 23 
optical image 21, 39 

FOCUS knob 9, 13 
FREZ button 8 
Gaussian profile 14 
Gun

bias 14 
shift 13 
tilt 14

Hardware description 6-11 
High voltage 12, 75 

indicator light 9 
Icon 2
ILLUMINATION knob 21 
Image Processing 

EDS spectra 55-56 
Line Analysis 45 
Map Analysis 50 
WDS qualitative spectra 60 

Imaging 21-24
(see also Printing or Photography) 21 
electron imaging 24

brightness, contrast, focus, magnification 9, 22, 24 
COMP (back-scattered electron imaging) 23 
display types 8
image preparation (finding sample, focusing) 22 
image types 8
SEI (secondary electron imaging) 22 
SEI conditions 8
single-element survey imaging 24 
SONY video specs. 8 
TOPO (topographic imaging) 24 
TV speed 13

optical (light) microscope 10 
optical imaging 21-22 

reflected light 21 
transmitted light 21 

IMS Signal 43,48 
INST button 8, 13
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JEOL reference manuals 1 
Joystick

controls 10
unfreezing 70 

kV range 76 
Lab description/correspondence

Denver 11
Menlo Park 11
Reston 10 

LEFT button 8 
LENS button 21 
Line Analysis 42-46

Convert to Point table. 44
entering lines 43
One-by-One, Preset measurements 44
preset measurements 45
Real-time display, viewing traverse 45
stopping analyses 45
survey measurements 45
viewing line scans, image processing 45 

Liquid Nitrogen tank low 68 
Load a Condition File 36 
Loading samples 18-19 
LSP (line scan profile) mode 8 
Magneto-optical (MO) disk 67 
Magnification 13

MAGNIFICATION knob 9
optical (light microscope) image 8 

Manuals, JEOL references 1 
Map Analysis 47-51

Calibration factors 50
Convert to Point Table 49
entering area coordinates 48
printout conditions, storing data 50
Real-Time display (viewing analyses) 50
starting measurement 49
viewing maps, image processing 50 

Measurement Mode
Quantitative Analysis 40
Standard Analysis 33 

Menu(s) 2 
MO disk

backing up data 67
restoring data 67 

MODE button 8 
Monitors 8

scan speed 8
SONY video 8 

Mouse functions
clicking, double-clicking and dragging 2
mouse buttons 4
over-clicking 69 

NOR mode 8 
Objective lens 9
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Objective lens aperture 13
OMTV button 13, 21
Optical (light) microscope 10
Optical focus 13
Optical imaging 21
PCD (pneumatic cup device/probe current detector) button 9
Peak identification

EDS qualitative analysis 55
WDS qualitative analysis 61 

Peak search 76 
PHA settings 75

(see also Voltage settings) 75
Quantitative Analysis 37
Standard Analysis 29 

Phase Analysis 62 
Photography 25
Plots, creating, printing (see also Data, Phase Analysis) 62 
Polaroid camera 8, 25 
Power outage 73
PRBSCN (probe scan) button 8, 9, 12 
Pre-set Measurement 34, 41 
Print-out Condition 33, 40 
Print-out, elements missing 75 
Printers 8 
Printing

(see also Photography)
Data (X-Text window) 34, 41
Images

electron images (SONY video monitor) 8, 25-27 
screen dumps (maps, line scans, etc) 27

Stopping dot matrix printer 70 
Probe current 76 
PROBE CURRENT knob 9 
Qualitative Analysis

EDS 56-57
WDS 58-61

identifying peaks 60 
image processing 60 
realtime display 59 
spectrometer conditions 58 

Quantitative Analysis 36-41
background measurements 41
beam (EOS) conditions 38
Correction Method 36
creating a file (new user) 36
data

Off-line Correction, recommended use/warnings about 64 
Summary Files (see also Data) 62

EDS 37, 38,40
EDS warning (bug) 41
flowchart B-7
focus analysis point 39
loading stored conditions 36
Measurement Mode (EDS/WDS) 40
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peak searches 41
points

analyzing a series of points (Preset Measurement) 40
analyzing single points (One-by-One) 40
areas, converting map coordinates 49
choosing, confirming, saving(Stage Condition) 39
focusing tips 39

Preset Measurement 41
spreadsheets, creating 63
standards

(see also Standard Analysis) 
choosing (Standard Conditions) 38

stoichiometrically calculated elements 37
stopping a measurement 41
storing conditions 40
Survey Measurement 40
traverses (line analysis) 44
valence for oxides 38
WDS analysis conditions 37
X-Text window 41 

Quick References
(see Table of Contents for specific document)
Bl-17

Rastering 9, 74 
READY light 10 
Reboot

soft boot 72
total shutdown (hard reboot) 72 

References 77 
REQ button 10 
Reset Analysis 71 
Reset buttons

EDS, WDS, console 72 
Restart

(see also Start-up)
after End of Menu 71
after power outage 73 

Sample change 18-19 
Sample preparation 18 
Screen dumps 27 
Seiko color printer 9, 27 
Serial Analysis 52-54

menu descriptions 53-54
warnings, recommended procedure 52 

Shut-down procedures 15-17
normal shut-down 15
run overnight 17
workstation 71 

SLOW button 8 
SONY video monitor 8 
SONY Video printer 8, 25 
Spectrometers

default conditions 70
positioning
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peak search 24
rate meter function 24

selecting 76 
Spreadsheet, 63 
SPT (spot) mode 8 
Stage

initializing positions 20
Stage Condition 28, 31,39
stage limit alarm 68 

Standard Analysis 28-35
analysis points

changing, confirming 32
choosing 31
eliminating data from (Check Data function) 33

baseline and window (PHA) voltage settings 29
copying, standard composition 35
data

Check Data function (see also Data) 33
deleting standard 28
EDS 30, 31
Element Condition

Standard Composition 29
EOS (analysis) conditions 30
Loading condition files 28
Measurement mode (EDS/WDS) 33
metals analyzing for 29
new standard 28
oxygen, analyzing for 29
Pre-set Measurement 34
Printing data (Print-out Condition) 33
renaming standard 28
search standardizations (Search function) 28
stage condition window 31
stopping analysis (cautions) 34
storing conditions, stage positions (Condition Store) 33
Survey Measurement 34
WDS Condition 29
WDS Elements 29
X-Text window 34 

Standard composition, copying 35 
Standard Conditions 38 
Standards

preferred 74
Start-up procedures 12-15 
Store a Condition File 33, 40 
STORE button 10 
Summary Files

quantitative analysis 62 
Survey Measurement 34, 40 
Telnet 67 
TEST button 10 
Totals (bad, low, high) 74-76 
Troubleshooting 68-76

alarms, communication lost 72
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common errors 69
processing hangups 71
spectrometers 70
totals bad (low/high), causes of 74-76
updating windows 70
useful information 69, 70 

UNIX
commands (glossary) A-2
file structure A-l
window A-l 

Vacuum 74
gauge 9, 12
normal reading 12 

Valence 38 
Video images

multiple images 27
printing

customizing, adding comments 26
printing, SONY video printer 25 

VIEW button 8 
Voltage settings 75 
Warnings

(see also Troubleshooting)
airlock 16
DG Workstation use 67
PHA/voltage settings 29
software (over-clicking) 2
stopping analysis 34
transmitted light arm 17, 18, 21 

Window 2 
Window functions 2-5

buttons 4
icons 2
key entry area or dialog box 5
maximize button (full screen) 3
menu button 4
menus 2
minimize button (iconize/iconify) 3
resize border 3
scroll bar 4, 5
title bar 3
two-dimensional display 5
windows 2

Workstation computer 10 
X-Text window

Quantitative Analysis 41
Standard Analysis 34 

X-Windows 2-5
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